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INTRODUCTION  

The ExamView® Assessment Suite v.6.1 (including the Test Generator, Test 
Manager, and Test Player) is a comprehensive solution for creating, administering, 
and scoring tests. The software includes many features to save you time and generate 
information to assess and improve student performance.  

 
Use the ExamView Test Generator to… 

• Create a paper test in less than five minutes.  

• Print multiple versions of the same test.  

• Enter your own questions. 

• Prepare an online test, study guide, and worksheet. 

• Upload question banks and tests to Learning Management Systems such as 
ANGEL, Blackboard, and WebCT. 

 
Use the ExamView Test Manager to… 

• Create or import a class roster. 

• Automatically score a paper test using a scanner. 

• Automatically score an assignment using CPS response pads. 

• Administer and score an online test. 

• Prepare a variety of useful class and student reports. 

 
Our mission is to enhance the learning process by providing superior products for 
students and educators. We believe that the ExamView Assessment Suite can truly 
enhance your classroom experience. 
 
One of the reasons our software is so widely used in classrooms is that we include 
educators and students in the design process. We invite you to share your experiences 
and feedback with us so we can make our products even better. Please email your 
comments to support@fscreations.com. 
 
To learn more about our products, visit our website at www.fscreations.com. 
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System Requirements 
To use the ExamView Assessment Suite v.6.1, your computer must meet or exceed the 
following requirements: 
 
Windows 
• Intel Pentium® II 120 MHz or compatible processor 

• Microsoft Windows® 98/ME/2000/XP/Vista (or more recent operating system) 

• 32 MB available memory for application (64 MB recommended) 

• 32 MB of available hard drive space 

• Monitor capable of displaying 16-bit color with 800 x 600 resolution 

• Internet connection to access the content updater, Web publishing, and  test-
hosting features 

 

Macintosh 

• PowerPC® 120 MHz or higher processor 

• Mac OS X (10.2 or later) 

• 32 MB available memory for application (64 MB recommended) 

• 28 MB of available hard drive space 

• Monitor capable of displaying 16-bit color with 800 x 600 resolution 

• Internet connection to access the content updater, Web publishing, and test-hosting 
features 

 
 
Notes:  

• The ExamView Assessment Suite includes a separate program called the 
ExamView Test Player that you can use to deliver online tests on your local 
area network. The system requirements are the same as those shown above 
except that the application requires a minimum of 16 MB available memory for 
the application and 8 MB of hard drive space. 

• Some ExamView Assessment Suite features require hardware devices such as 
response pads and scanners. These devices may have higher system 
requirements than those listed here. Check your hardware manufacturer’s user 
guide or website to verify that your system meets these requirements. 

• The ExamView Assessment Suite may be accompanied by tests or question 
banks provided by a publisher. All content in these tests/question banks falls 
under the publisher’s copyright. Please refer to the publisher’s copyright notice 
for additional information. 
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Installation Instructions 
Follow these steps to install the ExamView Assessment Suite. If you received the 
software from a publisher, the installer will automatically copy the publisher-supplied 
question banks to a new folder within the Banks folder and may install an additional 
Publish folder for storing files that are needed for publishing questions to the 
publisher-hosted server. 
 
1. Insert the ExamView disc into the CD-ROM drive of your computer. 

 Windows: If the autorun feature is enabled on your computer, a window will 
automatically appear on your screen. Click the Install button and skip to step 5. If 
the autorun window does not appear, proceed to step 2. 

Macintosh: If necessary, open the installer window then double-click the ExamView 
Assessment Suite installer icon. Proceed to step 5. 

2. Click the Start button and choose Run. 

3. In the Run window, type d:\setup.exe, replacing d with the drive letter that 
corresponds to the drive where the setup file is located. 

4. Click the OK button. 

5. Follow the instructions that appear on your screen. 
 
6. Remove the installation disc when finished. 
 
 
Notes: 

• FTDI drivers must be installed to use CPS response pads with ExamView. An 
installer for these drivers is automatically copied to the Extras sub-folder of the 
program directory as part of the complete installation of ExamView. Navigate to 
this folder and run the driver installer if they are needed. You may also visit 
www.einstruction.com to download the latest version of the required drivers. 
These drivers are already installed if Classroom Performance System software is 
installed. 

• To uninstall the ExamView software for Windows, choose Control Panel from the 
Start menu then select Add or Remove Programs. Removing the program does 
not delete any banks or tests. You must manually remove those files. Macintosh 
users simply delete the program folder to uninstall the software. 
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Getting Started 
After you complete the installation process, follow the instructions below to start the 
software. Start the ExamView Test Generator if you want to create a test, open an 
existing test, create new questions, or work with a question bank. Use the ExamView 
Test Manager to create a new class roster, assign an online test to a class, get results 
from an online test, score a paper test using a scanner, or print a report. 
 
ExamView Test Generator 

1. Windows: Click the ExamView Test Generator shortcut on your desktop. If you do 
not have a shortcut, click the Start button. Highlight the Programs menu and locate 
the ExamView Pro Test Generator folder. Select the ExamView Test Generator 
option. 

Macintosh:Locate the ExamView Pro folder on your 
hard drive and double-click the ExamView Test 
Generator icon.  

2. The first time you run the software, the program 
prompts you to enter your name, school/institution 
name, and city/state. Enter the requested 
information. 

3. Choose one of the options in the Welcome Screen.  

Each time you run the ExamView Test Generator program, the program displays 
the Welcome Screen. You can choose to create a test using the Test Builder or 
enter your own questions using the Question Bank Editor. 
 

  

Use ExamView 
Test Generator 
to create a test or 
work with a 
question bank. 
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ExamView Test Manager 

1. Windows: Click the ExamView Test Manager shortcut 
on your desktop. If you do not have a shortcut, click the 
Start button. Highlight the Programs menu and locate 
the ExamView Pro Test Generator folder.  

Macintosh: Click the ExamView Test Manager icon in 
the dock. If you do not see this icon, locate the 
ExamView Pro folder on your hard drive. Double-click 
the ExamView Test Manager icon. 

2. Choose one of the options from the Welcome Screen.  

Each time you run ExamView Test Manager, the program displays the Welcome 
Screen. You can choose to start a new class or open an existing class. 

 

 

 

 

 

 

 

 

 

 

 

 

Help Topics 

Detailed help instructions are always available if you need assistance using the 
ExamView software. Click the Help button or choose the Help Topics option from the 
Help menu to view step-by-step instructions. If you have trouble while you are working 
with the software, you may want to review the troubleshooting tips or visit the online 
Support Forum (forum.fscreations.com). 

Use ExamView 
Test Manager to 
assign an online 
test, get results, 
or print reports. 
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CREATE A TEST  

The ExamView Test Generator program provides all the tools you need to create a 
paper test or an online test from your own questions or from those provided by a 
publisher. You can use the QuickTest Wizard to select the questions for a test, or you 
can use one or more of the other question selection options.  

 

After you create or build a test, you can change the instructions, reorder the 
questions, change the layout, print the test, or publish an online test. 

 
 
Use the QuickTest Wizard 
If you want to create a test quickly with randomly selected questions from one or 
more question banks, use the QuickTest Wizard. The wizard guides you through the 
step-by-step process of selecting questions for a new test. 
 
To create a test with the QuickTest Wizard… 

1. Launch ExamView Test Generator. A welcome screen 
with several options will appear. Choose the Create a 
new test using a wizard option. 

2. Name your test. 

3. Select the question banks from which you want to 
choose questions. 

4. Identify how many questions of each type you want on 
your test and click the Finish button. 

 
That’s all there is to it! If you want, you can customize the appearance of your test 
using the many formatting options or you can select additional questions.  
 

 

You can also click 

the  button in 
the toolbar to start 
the QuickTest 
Wizard. 
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Build a New Test 
The ExamView Test Generator offers several question selection options to create a 
new test. You can use the QuickTest Wizard or one of the other six options. The option 
you choose depends on your particular needs. For example, you can select questions 
by viewing the actual questions and deciding which ones to include on your test. Or, 
you can select questions by learning objective or standard. 
 
To build a new test… 

1. Launch the ExamView Test Generator. A welcome 
screen with several options will appear. Choose the 
Create a new test from scratch option. 

2. Name your test. 

3. Choose one of the question selection options from the 
Select menu, or click the corresponding toolbar button.  

Select Randomly - Choose this option if you want to select questions 
randomly. You can choose how many questions you want for each question 
type (e.g., multiple choice, true/false, short answer, etc.). 

Select from a List – If you have a printout of your question banks, you can 
manually review the questions and choose the ones you want to include on a 
test by writing down the question numbers. Then, use this option to select the 
question numbers from a list. 

Select While Viewing – Use this selection method if you want to view the 
questions and make your selections one at a time while viewing them. 

Select by Standard – If your questions include learning objectives, local 
standards, state standards, or national standards, use this option to easily 
select questions based on this information. 

Select by Criteria – Choose this option to select questions that match criteria 
you enter. For example, you can select  all of the multiple choice questions 
that cover a certain topic and include specific keywords. 

Select All – Choose this option if you want to quickly select all of the questions 
in a bank or group of banks. 

You can also click 

the  button in 
the toolbar to 
create a new test. 
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4. After you choose a question selection option, identify which question banks you 
want to use to create the test.  

Highlight one or more question banks and click the Select button. The question 
banks you choose appear in the lower portion of the window. Click the Next button 
to move to the next step.  

Note: If the question bank(s) you want does not appear in the list, click the Folder 
button to locate the question bank(s). 

5. Use the options provided to select the questions that 
will appear on your test. 

Depending on which question selection option you 
chose, ExamView Test Generator displays a window 
with the options you need to build a test. 

6. Change the appearance of the test, print the test, or 
publish it online. 

7. Save the test. 

 

If you need help 
using any of the 
selection options, 
click the Help 
button for detailed 
instructions. 
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Customize the Appearance of a Test 
ExamView Test Generator includes numerous features that allow you to customize the 
appearance of a test to your exact specifications. A few of the more popular options 
are listed here, but you can refer to the help topic Customizing the Appearance of a 
Test for a complete list. 
 
Answer Space 
Depending on how your students will complete the test, you can turn on or off space 
for answers. For example, if you want your students to write the answers on the test 
next to each question, you can provide space to do so. If your students will be using a 
bubble sheet or a separate piece of paper, you can show only the questions. Choose 
Layout from the Test menu. Click the Answers tab and set the corresponding options 
in the Answer Space area. (Note: Some answer space options are disabled when tests 
are set to display in two-column format.) 
 
Mix Question Types 
You can choose to group questions on a test by question type (e.g. multiple choice, 
true/false, etc.) or mix the question types. When questions are grouped by question 
type an instruction line describing how to answer questions of this type appears. 
 
Often state tests do not group questions by question type. If you want to create a test 
that more closely resembles a state test you can mix the question types. Choose 
Layout from the Test menu. Click the Question Types tab and select Allow question 
types to be mixed. Reorder the questions to mix the question types (see the 
Reordering Questions section in this user guide). 
 
Two-Column Formatting 
You can display tests in one- or two-column format, whichever best fits your testing 
needs. Choose Layout from the Test menu. Click the Page tab and select Two 
Columns. Choose whether or not you would like vertical and horizontal lines included 
on your test. 
 
Reordering Questions 
Changing the order of questions is a snap. Just choose 
Reorder from the Question menu, and you can drag and 
drop the questions to your liking. If your test is set to group 
questions by question type, your questions must remain 
grouped by question type when reordering. You cannot 
move a single true/false question to a position after the 
multiple-choice questions. Instead, you must move the 
entire group of true/false questions. 
 
If your test is set to allow for mixed question types, you 
can click Sort in the Reorder Questions dialog box to sort questions by question 
criteria. 

You can manually 
reorder or scramble 
questions. Also, 
when you print a 
test, there is an 
option to scramble 
the questions. 
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If you want to scramble the questions, choose Scramble from the Question menu. From 
there, you can choose to scramble sections, questions, and the answer choices in 
multiple choice and multiple response questions. 
 
Replace Font 
If you want to change the font of your entire test, choose Replace Font from the Edit 
menu. Select the fonts and sizes you want to use, and click the Replace All button. All 
questions in your test will instantly update with the newly selected font choices. 
 
Note: If you use the Replace Font option to replace a font, it is best to replace one 
font (e.g., Times New Roman) with another (e.g., Arial). Do not choose to replace all 
fonts with another font. This could cause unintended results such as replacing symbols 
or other special characters (e.g., Symbol). 
 
Adjust Multiple Choice 
Do you need to alter a multiple choice test for a special-needs student? Choose Adjust 
Choices/Columns from the Question menu to adjust your test. You can instantly 
reduce the number of choices in all of your multiple choice questions.  
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Layout and Style 
Several state and national test styles are built into the ExamView Test Generator. 
Instantly format your test by choosing a style from the Style Gallery. For example, if 
you want to format your test to look like the PSAT, choose Style Gallery from the Test 
menu. Select the PSAT option and click the OK button. 
 
If you do not see a style that suits you in the Style Gallery, you can customize the test 
with the Layout and Style commands. Choose Layout from the Test menu, and set the 
layout options. Then click the Style icon and choose your fonts and styles. The figure 
below shows an example of a test with a customized bubble sheet style. 
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Print a Paper Test 
After you create or open a test, you can print a paper test in just a few simple steps. 
When you choose to print a test, the ExamView Test Generator prints the test and 
the answer key exactly how it appears on screen.  
 
To print a test… 

1. Choose Print Test from the File menu, or click the  toolbar button. 

2. Set the print options. 

If you choose two or more versions of the test, you can choose to scramble the 
questions using several options. If the test includes dynamic questions, the 
ExamView Test Generator can calculate new values for each test. 

As part of the test, you can print an answer strip to make it easier to score paper 
tests and a version map that identifies how questions align on each version of a 
test. 

Windows only: To print a bubble answer sheet, select the Print Bubble Form 
option from the File menu. Refer to the Print a Bubble Form section in this user 
guide for further details. 

3. Click the OK button. 

Note: If you received the software packaged with tests or question banks provided 
by a publisher, please refer to the publisher’s copyright notice for information on 
the distribution of printed tests. 
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Print a Bubble Form (WINDOWS ONLY) 
Using either the ExamView Test Generator or ExamView Test Manager, you can print 
bubble forms to accompany your test. These forms are compatible with the plain-
paper scanning feature of the ExamView Assessment Suite. Refer to the Plain-Paper 
Scanning section of the Score Paper Tests with a Scanner section in this user guide. 
 
(Windows only) To print a bubble 
form… 

1. Choose Print Bubble Form from 
the File menu. 

2. Select the form that best fits your 
assessment needs. 

When highlighted, a description 
of the selected form will be 
displayed on the right. 

Note: Visit our website (www.fscreations.com) to download additional forms. 

3. Click the OK button. 
 
 
Publish or Export an Online Test 
The ExamView Test Generator lets you publish a test in a variety of online formats. 
Regardless of the online testing option you choose, the steps to build a test are the 
same as those you use to create a paper test.  
 
Online testing options… 

• Publish a test for use on your local area network (LAN). 

• Publish a test to the ExamView Learning & Test Center or a publisher’s 
website. 

• Export a test as an HTML document that you can post to your own website. 

• Export a test for use with your ANGEL, Blackboard, or WebCT learning 
management system (Windows only). 

• Publish a test directly to ANGEL or WebCT (Windows only). 

 
The online testing format that you choose depends on your specific needs. Refer to 
the other sections in this manual for a complete description of the various options. 
Detailed instructions are available to guide you through the process of publishing an 
online test. 
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Working with Learning Management Systems (WINDOWS ONLY) 

The ExamView Assessment Suite works with Learning Management Systems (LMS) 
including ANGEL, Blackboard and WebCT (Campus Edition and Vista). Tests and question 
banks can either be published directly to or exported to a file format that can be 
uploaded to these LMS.  
 
 

 

 

 

 

(Windows only) To publish a test or question bank… 

1. Start the ExamView Test Generator and create or open a test or question bank. 

2. On the File menu, point to Publish To, and then click the target Learning 
Management System. 

3. Select the LMS server profile and click OK. 

4. Complete the options in the dialog and click OK. 

5. Login to your LMS to view the ExamView content. 

 

(Windows only) To export a test or question bank… 

1. Start the ExamView Test Generator and create or open a test or question bank. 

2. On the File menu, point to Export, and then click the target Learning Management 
System. 

3. Name the file and click Save. Complete the options in the dialog and click OK. 

4. Login to your LMS and upload the exported test/question bank. 
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ENTER YOUR OWN QUESTIONS  

When you build a test using the ExamView Test Generator, you do so by selecting 
questions from question banks. A question bank (or bank) is a collection of questions 
and all of the related items (pictures, equations, learning objectives, standards, etc.) 
stored in one file. Each question bank may contain up to 250 questions, but you can 
have an unlimited number of banks. Typically, questions are organized into banks by 
chapter or lesson. 

 

Using the ExamView Test Generator, you can… 

• Enter new questions or edit existing questions. 

• Copy and paste questions from another source. 

• Using the EV Import Utility, import questions from a Word document or an RTF 
file (Windows only). 

 

IMPORTANT: You can create a new question or edit a question while building a test. 
However, editing a question after it is included on a test does not change the original 
question in the question bank. You must edit questions or add new ones in a question 
bank to make those questions available when you build your tests. 

 
 
Question Bank Basics 
If you have not used the ExamView Test Generator to create your own questions, 
there are a few things to consider before you get started. For example, you can 
include more information than just the question (e.g., answer, learning objective or 
standard, student feedback, etc.). Take a few moments to review the information 
presented here before you begin the next section. 
 
Question Types 
When you create your own questions, you can include one or 
more of the following question types. 
 

True/False 
Modified True/False 
Multiple Choice 
Multiple Response 
Bimodal 

Yes/No 
Numeric Response 
Completion 
Matching 
Short Answer 

Problem 
Essay 
Case 
Other 

 

You can use a 
bimodal 
question as a 
short answer 
or a multiple 
choice 
question on a 
test. 
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 Question Information 
Questions can include optional information that is useful 
when creating a test. For example, you can include 
learning objectives (or standards) and then select questions 
based on those objectives. You can also use this 
information to generate class and student reports. You can 
enter any or all of the following information with each 
question. 
 
Difficulty 
Reference 
Learning Objective 
National Standard 

State Standard 
Local Standard 
Miscellaneous 

Topic 
Keywords 
Notes 

 
Question metadata can be directly keyed into the appropriate information field or 
added using a list. To view the list, place the cursor in the information field of interest 

then click the  button. The default pick list is composed of question information 
already present in other questions in the currently open bank or test.  
 
 
Windows only: The pick list can be changed so that the default list is merged with 
contents from an external list source. List files must conform to a specific formatting 
convention and be stored in the Extras folder of the ExamView directory. Refer to the 
List Authoring Guidelines help topic in the program for details on creating custom 
pick lists. 

(Windows only) To change the pick list source… 

1. Click the  button to reveal a menu with available lists. 

2. Select a list file name or choose to Restore Default. 

• The name of the List Source is shown above the 
list. This source will either show “Default” or the 
name of the list file. 

• The default list contains only unique entries 
already recorded for questions in the active file. 

• Selecting an external list file merges the entries 
of that file with the default list, it does not 
replace it. Entries for the external list file and the 
default list are combined and sorted together 
alphabetically. 

• Only one file will be added to the default list at a time. 

Use the pipe ( | ) 
character to enter 
more than one 
data element 
such as a state 
standard – 
MA3-1.2 | MA4-1. 

Common metadata 
information can be 
saved in a list file 
and shared or 
distributed to 
standardize the 
entries by multiple 
authors. 
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• If the external list file does not contain any entries for a particular category, the 
list will not appear to change. However, other categories that are contained in 
the external file will be updated. 

 
Check for Content Updates 
ExamView question banks are periodically updated to keep state standards and 
question content current. Using the Check for Content Updates option in the Help 
menu, you can check for updates as often as you like (requires an Internet connection). 
 
Student Feedback 
If you use the ExamView Assessment Suite to deliver online tests, you can include a 
rationale and student feedback for each objective-based question (e.g., multiple 
choice). As a result, you can set up your online tests to display feedback for incorrect 
responses.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Narratives 
A narrative is a table, a descriptive passage, a special instruction, a picture, or other 
information that can be attached to (or linked to) one or more questions. All questions 
linked to the same narrative print together as a group on a test. Possible uses for a 
narrative include a reading passage, map, chart, or photo. 
 
Images 
You can easily insert an image (e.g., graph, map, photo, etc.) into a question or an 
answer. Or, you can copy and paste an image from another program. Whichever option 
you use, be sure to consider the size and readability of the image. 

For paper and 
online tests, you 
can print a report 
with the rationale 
for each item a 
student answers 
incorrectly. 
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Color images and photos can use a lot of memory that, in turn, 
increase the size of the test or question bank file. For example, a 
single color photo can be 1-2 MB. For paper tests, the size of an 
image is not that critical. However, the image size does affect 
online tests. Imagine students downloading a test via the Internet 
that includes three or four photos. If you use color images, use the 
lowest possible resolution.  

 

If you plan to include an image in a question, you should check the 
image for readability. Can you read the information on your screen 
and on paper? If you create your own art, use a larger font for text 
that appears as part of an image.  For best results and smaller file 
sizes, use black and white or 256-color images. 

 

Other Issues 
If you create your own questions or edit existing questions, consider these additional 
guidelines.  
 
When you create your own questions… 

• Do not write questions that refer to another question or depend on a particular 
question order. Remember that you can scramble questions on a test. And, if 
you randomly choose questions, you may not get all of the questions you need.  

• Use tables, not tabs, if you need to create tabular material. Tables work much 
better, especially for online tests. 

• Use standard fonts (e.g., Times New Roman, Arial, etc.). If you use other fonts, 
you may have difficulty sharing the question banks with someone who does not 
have the fonts you used. This can be a problem for online tests too. 

• For multiple choice and multiple response questions, be sure to set the scramble 
options for questions that include choices such as All of the above or None of 
the above. You would not want one of these choices to appear as choice a or b. 

• Do not worry about entering the instructions for the questions. ExamView Test 
Generator automatically includes instructions for each question type. (Note: 
question type instructions are not shown when tests are set to allow for mixed 
question types.) 

• For questions that require specific instructions add the instruction line to the 
question stem or within a narrative. 

• Questions that contain wide images, tables, or equations will not display in two-
column format. If you plan to format your test with two columns, try to keep 
your images to roughly three inches or smaller in width. 

You can edit a 
question and 
double-click an 
image to see how 
much space it 
requires. You can 
also reduce the 
color setting of 
the image.
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A Hands-On Tutorial 
This section provides a tutorial that will guide you step-by-step through the entire 
process to create a question bank using the ExamView Test Generator. You will learn 
how to create a variety of question types, save the bank, use a narrative, insert art, 
enter question information, and print a question bank. 
 
Create a New Question Bank 
1. Start the ExamView Test Generator program. 

2. Choose Create a new question bank from the Welcome Screen. 

If you are currently working in the test builder, choose Switch to Question Bank 
Editor from the File menu and then select the option to create a new bank. 

 

 

 

 

 

 

 

 

 

 

3. Name the question bank ExamView Sample Bank and click the OK button. 

An empty question bank page (except for the title) appears on your screen. If you 
want to edit the title, simply double-click it and change the title. 
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Enter True/False Questions 

1. Click the New button at the bottom of the window. 

2. Choose True/False and click the OK button. 

The question entry screen for a true/false question will appear. Depending on the 
question type, the entry screen provides different options. For example, the 
multiple choice screen includes space to enter each choice. 

3. Type the following question in the question entry area. 

Using ExamView you cannot create different versions of the same test. 

4. Use the Answer pull-down menu in the lower right corner of the window to set the 
answer to False. 

5. Click the Info button at the bottom of the window. 

6. Type Easy for the difficulty, 221-223 for the 
reference, and click the OK button. 

7. Click the Record button. 

You should see the question you just entered on the 
question bank page. If you do not see the question 
information immediately after the question, choose 
Preferences from the Edit menu. Click the Layout 

By default, all 
questions are 
assigned a value 
of 1 point. You 
can change the 
points in the 
Question Info 
window. 
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icon, and then the Question Information tab. Select the options to show difficulty 
and reference. 

8. Proofread the question. If you need to make any changes, double-click the question. 
Or, highlight it and click the Edit button at the bottom of the window. 

9. Create two more true/false questions using the following information. 
 
 

ExamView gives you almost complete control over the appearance of a test so 
that you can customize it to meet your testing requirements. 
 
ANS: T  DIF: Easy  REF: 245 
 
 
Stylized text, fonts, and special characters cannot be used in a test question. 
 
ANS: F  DIF: Challenging  REF: 237 

 
 
Save the Question Bank 

1. Proofread your work and make any changes as 
needed. 

2. Choose Save from the File menu. 

3. Enter a question bank file name, and select a 
location where you want to save the file. 

4. Quit the program, or continue with the next part 
of this tutorial. 

 
 
 
Create Multiple Choice Questions with a Narrative 

1. If necessary, start the program and open the 
question bank you just created for this tutorial. 

2. Click the New button, and choose to create a 
multiple choice question. 

Be sure to save 
your question bank 
on a regular basis. 
From time to time, 
make a backup of 
your files. 

You can also press 
Ctrl+N (Windows) 
or Cmd+N 
(Macintosh) to 
create a new 
question. Or, 
choose New from 
the Question 
menu.  
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3. Enter the following question, answer, and question information. 
 

Based on Table 1-1, ExamView 6 includes which feature? 
 
a.  QuickTest Wizard 
b.  Two-Column Layout 
c.  Select by Standard 
d.  All of the above 
 
ANS: D           DIF: Average           REF:  242-245 

4. Set the answer to d. 

5. Choose a-c in the Scramble box to scramble choices a-c only when you create a 
test, and set 1 for the columns. 

6. Click the Narrative button, click New, and enter the following narrative.  

 Use the Table menu to insert a table. If you have time, format the table as shown 
below. Center the information in the last two columns, shade the first row, and 
make the column labels bold. 

  
 ExamView 5.0 ExamView 6.0 

QuickTest Wizard Yes Yes 
Two-Column Layout No Yes 
Internet Test-Hosting Yes Yes 
Select by Standard Yes Yes 
Mixing Question Types No Yes 

  Table 1-1 

7. Enter EV Table 1-1 for the narrative name and click 
the Record button. 

8. Click the Done button to return to the question 
entry window. 

9. Record the question. 

When you record the question, both the question 
and the narrative appear together. 

It is important to 
use a unique 
name for each 
narrative you 
create. 
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10. Enter the following question, answer, and question information. 
 

Based on Table 1-1, ExamView 5 does not include which feature? 
 
a.  QuickTest Wizard 
b.  Internet Test-Hosting 
c.  Mixing Question Types 
d.  Select by Standard 
 
ANS: C           DIF: Average           REF:  242-245 

11. Click the Narrative pop-up (not the button) and choose the EV Table 1-1 narrative 
to link this question to the table you already created. 

12. Record the question, and be sure to save your work. 
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Enter Completion Questions and Run Spell Check  

1. Choose to create a new completion question. 

2. Enter the following question, answers, and question information. 

Notice that the question has three possible answers. For online tests, students can 
respond with any one of the answers. 

 
ExamView is a computer ____________________ 
that allows you to build paper and online tests. 
 
ANS: 
program 
application 
tool 
 
DIF: Average         REF: 247 
 

3. Enter the next question, answer, and question information. 
 
 

Use the online ____________________ whenever you need additional 
instructions to use the ExamView software. 
 
ANS: help              DIF: Easy            REF: 251 
 

4. After you record the question, choose Spell Check from the Edit menu. 

5. Save your work. 
 
 
 
Create a Short Answer Question with a Picture  

1. Choose to create a new short answer question. 

2. Enter the following question, answer, and question information; but do not record 
the question. 

 
Describe the picture above. What format is used and how big is it? 
 
ANS:  Student answers will vary depending on the picture used. 
 
DIF: Average            REF: 277 

Use the Shift key 
and hyphen to 
create the space 
to write an 
answer. 
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3. Insert one or two blank lines above the question, and move the cursor to the first 
line. 

4. Choose Picture from the Insert menu, locate a picture, and insert it into the 
question.  

If you cannot find a picture, start a paint program and create a simple illustration. 
Then, copy and paste the picture into the question. 

5. After you insert a picture, double-click the image and choose the Picture tab.  

This window shows the memory size for the image. You can also change the color 
settings here.  

 

 
 
 
 
 
 
 
 
 
 
 

 
 

6. Close the Format Picture window and record the question.  
 

Remember to 
keep the memory 
size of each 
picture as small 
as possible. 
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Wrap Things Up  

1. Save the question bank. 

2. Print a copy of the questions and review them. 

3. Make any needed changes.  

Remember that you can double-click a question or narrative to edit it. Or, you can 
highlight an item and click the Edit button. 

If you want, switch to the Test Builder using the File menu and choose to create a 
new test. Use the questions you just entered to build your test. Notice that as you 
build the test, the instructions automatically appear (provided that your test is set 
to group questions by question type). 

4. Quit the program. 
 
 
 
 
Copy and Paste Questions 

If you have questions in another format (e.g., word processor, another test generator, 
database, etc.), you can copy and paste questions from that program into the 
ExamView Test Generator. While this is a simple process, it can be time consuming. 
Usually, the copy and paste method is best for just a few questions. 

Note: If you have many questions in a word processor format such as Microsoft Word, 
you can use the ExamView Import Utility (Windows only) to quickly import your 
questions. Refer to the next section for instructions. 
 
To copy and paste questions… 

1. Choose to create a new question in a question bank or a test. 

2. Highlight and copy the text (e.g., from your word processor) that you want to paste 
into a question. 

3. Switch to the ExamView Test Generator question entry window. 

4. Paste the text into the question. 

Depending on the question type, you may have to copy and paste the question 
separately from the answer. However, you can quickly copy/paste multiple choice 
and multiple response questions. Using the SmartPaste option, you can 
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automatically copy the choices into the appropriate places in the question entry 
window. 

To use SmartPaste, highlight an entire multiple choice or multiple response 
question including the choices (a. b. c. d. e.) in your word processor and select 
Copy. Switch to the question entry window and press F7 (not Ctrl/Cmd+V or Paste).  

 
 
 
Import Questions from a Word Processor (WINDOWS ONLY) 

If you have all or most of your questions in a word processor format such as Microsoft 
Word, you can use the EV Import Utility (installed with the other ExamView 
Assessment Suite programs, for Windows only) to import your questions into the 
ExamView Test Generator format very quickly. The program includes step-by-step 
instructions that explain how to import your questions.  
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WORKING WITH CLASSES AND ASSIGNMENTS  

The ExamView Test Manager provides the features you need to track results for paper 
and online tests. To begin, you must create a new class. Then, you can manually enter 
the student information or import a roster from another format such as your 
gradebook. Follow the steps in the appropriate section to create a new class and enter 
your roster. 

IMPORTANT: You do not have to create a new class if you do not plan to track student 
results or give online tests. 
 

Create a New Class 
Before you enter student information, you must create a new class. To do so, you must 
enter information about your class (e.g., class name, class ID, period, and section) and 
yourself (name, ID, school name, school ID, city, and state). Just a few of the fields 
are required. Other fields, such as the password and school ID, are optional. 

To create a new class… 

1. Launch the ExamView Test Manager. A startup 
window with two options will appear. Choose the 
Start a new class option. 

 If you are already working with the ExamView Test 
Manager, save the current class and choose New 
Class from the File menu. 

2. Enter the class name and other fields as needed.  

3. Enter your name, school name, city, and state. The other fields are optional. 

4. Click the OK button to record the class information. 

 
 

You can change 
the information 
at any time by 
choosing Class 
Information in 
the Edit menu. 
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Enter Student Names and IDs Manually 
After you create a new class, the next step is to enter your students. At a minimum, 
you must enter each student’s name and assign an ID. You may also enter an alias, 
password, and pad ID. ExamView Test Manager provides an option to show the alias 
instead of the name and ID on reports. You can assign a unique password to each 
student to use when taking an online (LAN) test and a pad ID for collect assessment 
data using eInstruction response pads. 

 

ExamView Test Manager allows you to generate reports using optional demographic 
information such as gender, socio-economic factors, race, and custom fields (e.g., 
instructor, location, etc.). Simply click the More button in the New Student window 
to display the data entry fields to record this information. 

To enter student information manually… 

1. Continue from the previous section where you created a new class. Or, start the 
ExamView Test Manager to begin a new class or open an existing class. 

2. Click the  toolbar button or choose Add New 
Student from the Student menu. 

3. Enter the student’s first name, last name, and ID. 

 Note: If you plan to use a scanner, use digits only 
(e.g., 520403) for the ID. Most scanner forms 
provide for numeric IDs only. For online testing, use 
unique student IDs across all of your classes. To use 
eInstruction response pads, be sure to assign pad ID 
values (1-1000). 

4. Click the Next button to record the student. 

 When you click the Next button the program records the student and clears the 
data entry field so that you can enter the next student.  

5. Repeat steps 3 and 4 to enter all of your students. 

6. Click the OK button when you are finished entering students. 

The Student Alias, 
Password, and Pad 
ID fields are 
optional. 
 
Click More to view 
additional student 
fields. 
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Import a Class Roster 
ExamView Test Manager makes it easy to import your student roster from other file 
types. At a minimum, the file must include the student’s first name, last name, and 
unique student ID.  

 

Import Class Roster from Text 
The text file can be either comma- or tab-delimited, include the fields in any order, 
and contain additional information. In just a few steps, you can quickly map the 
pertinent information and start the import process. 

To import a class roster from a text file… 

1. Start ExamView Test Manager to begin a new class or open an existing class. 

2. From the File menu, select Import then the Class Roster from Text... option. A file 
selection window will appear. 

• The text file can contain comma-delimited or tab-delimited data elements. 

• Text files can be “.txt” or “.csv” 
formats. (Windows also recognizes the 
“.tsv” file format) 

3. Macintosh: Select the text file to import 
and click the Import button. The Import 
Class Roster from Text dialog will appear. 

Windows: Select the text file to import and 
click the Open button. The Import Class 
Roster Wizard start-up screen will appear. 

4. Macintosh: Using the pull-down menus, 
map each Test Manager field to the data 
element in the text file. At a minimum, 
the first name, last name, and student ID 
must be mapped. Click the OK button to 
complete the import. 

Windows: Select the option to Start a 
new import definition profile or, if 
available, Load an existing import 
definition profile then click the OK 
button. The first step of the Import Class 
Roster Wizard will appear. Follow the 
instructions in the next sections to 
complete the import process. 
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(Windows only) About import definition profiles… 

• All settings and mapping choices made while using the 
Import Class Roster Wizard are stored in the import 
definition profile (“.tid” file). If the profile is selected 
in a future import, these setting are loaded into the 
wizard dialogs. You must still click through the steps of 
the wizard. You may choose to use the definition profile 
without any changes or make adjustments to the import 
mapping and save the definition as a new profile. 

• At the end of the import mapping process, you will be 
asked if you want to save the import definition profile. 

• You can save your progress in the Import Class Roster 
Wizard at any time by closing the window or clicking the Cancel button. You 
will be asked if you want to save the import definition profile. 

• The list of available import definition profiles is made from saved “.tid” 
definition files stored in the Extras folder within the ExamView program folder. 

 

(Windows only) Completing the Import Class Roster Wizard, step 1… 

1. Set the row number to start importing student roster records. 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Use the Preview window to view the first 10 rows of the text file. The row 
numbers are included in the preview. 

Import definition 
profiles that are 
common for a 
school or district 
can be created 
and distributed 
or shared. Simply 
add the “.tid” 
file to the Extras 
folder in your 
ExamView 
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• Many text rosters contain header information, a row of labels for each data 
column. You should not import the header row. 

• If the desired import starting point is more than 10 rows into file, it is 
recommended that you delete the unnecessary rows from the file prior to 
import. 

2. Indicate how the student names are formatted in the text file by selecting the 
appropriate radio button. 

3. Click the Next button. 

 

(Windows only) Completing the Import Class Roster Wizard, step 2… 

1. Drag the names of field that you want to import from the text file to the target 
boxes next to the corresponding Test Manager field name. Field names not dragged 
into a target box will not be imported. 

• Student name and Student ID fields are required for import, all other fields are 
optional. 

• Student IDs must be unique for the record to successfully import. If a duplicate 
ID is found in the existing class or within the text file, that record will not be 
imported. A status message at the end of the import process will report if any 
records were skipped and how many were skipped. 

• Field names can be dragged to more than one target box. For example, the 
student’s last name can be mapped to both Last Name and Password. 
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2. Use the arrow buttons to advance or reverse the contents being previewed. 

• The preview will be updated in both the Source Text Fields list and in the 
import target boxes. This is a useful tool for verifying that the desired import 
data is mapped to the proper Test Manager category. 

3. Click the Next button. 

 

(Windows only) Completing the Import Class Roster Wizard, step 3… 

1. Value restricted fields correspond to check boxes in the Student Information dialog 
and require additional mapping to indicate which check box should be selected. 
Value restricted fields flagged for import will display either a checkmark or warning 
icon next to their name. To ensure successful import of all the desired data, 
advanced field mapping should be performed until no warning icons are displayed. 
Click the Edit Mapping button to perform this step. 

• Value restricted fields not flagged for import will have the Edit Mapping button 
disabled. 

• You may continue with the import process and ignore the warnings, but values 
that are not mapped to a check box will be ignored when imported. 
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2. If flagged for import, select the format for the date of birth data using the drop-
down list. 

• Only digits can be used to indicate month (M), day (D), and year (Y) values. 
Dates cannot use strings such as "August" or "Aug." for the month. 

• Digits can be contiguous (e.g. MMDDYYYY) or separated by slashes (e.g. 
MM/DD/YYYY), dashes (e.g. MM-DD-YYYY) or spaces (e.g. MM DD YYYY). 

• Year values can be specified using four digits or just the last two digits 

3. Click the Finish button. A message will appear asking if you want to save the 
import definition profile. 

4. Save the import definition profile by clicking the Yes button, continue to import 
without saving the profile by clicking the No button, or click Cancel to return to 
the wizard. 

5. After the import process is complete, a message will appear showing the number 
of student records successfully added and the number of records that were 
skipped. 

 

Much of the student demographic information is presented as a series of check boxes. 
These value restricted fields include: Gender, Grade Level, Sociological/Economic, 
Race/Ethnicity, and Other. If any of these categories are flagged for import, additional 
mapping will need to be performed to associate text terms with each check box. 

 

(Windows only) To perform advanced import mapping… 

1. Key entries for acceptable matches into the text fields next to the Test Manager 
Category. 

• Separate multiple entries with commas. 

• Text matching is not case-sensitive. 

• You can copy entries from the Unique File Entries list and paste them into the 
Text Matches field. 

• Mapping is not limited to the entries present in the current file. To make the 
import definition profile more generalized, you may key in values not shown in 
the Unique File Entries list but anticipate needing in a future import. 
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2. Refer to the Unique File Entries list to determine if all unique entries have been 
mapped. Entries not yet mapped will appear in red. Click the Update List button to 
refresh the list. A warning icon will continue to be shown in the import wizard until 
all entries have been mapped. 

• All value restricted fields have an Ignored entries sub-category. If you do not 
want a particular entry to be imported, key it into this field. Entries listed here 
will not be imported, but they will no longer appear unmapped and cause the 
warning icon to appear in the import wizard. 

3. Click the OK button to return to the import wizard. 
 

 

 
Import Class Roster from CPS Database/Package 
Test Manager allows you to quickly import your class roster from an existing CPS 
database (Windows only) or CPS Package (Windows/Macintosh). Student last names, 
first names, pad IDs, student IDs, and other available student information are 
imported into the Test Manager class file. 

To import a class roster from a CPS database/package… 

1. Start ExamView Test Manager to begin a new class or open an existing class. 

2. From the File menu, select Import then the Class Roster from CPS... (Windows) or 
Class Roster from CPS Package… (Macintosh). A file selection window will appear. 

3. Select the CPS database (“.cps” file) or CPS package (“.cxm” file) to import and 
click the Open button. 
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• Test Manager requires that a unique student ID is assigned to every student. 
Either assign student IDs to all students within CPS prior to import or select the 
option to automatically add student IDs to the imported roster. 

• A maximum of 1000 students can be imported into Test Manager. If the CPS 
database contains more than 1000 students, you will have the option to import 
just the first 1000 records or cancel the import.  

4. If more than one roster is detected in the database file, a list will open showing the 
roster names and number of students in each roster. Select the roster to import and 
click the OK button. 

5. The roster is imported and a summary of the number of imported student records 
will appear. Click the OK button. 

 

 

Export a Class Roster 
ExamView Test Manager easily allows you to export your student roster for use in 
other programs.  
 

Export Roster as Text 

At a minimum, the exported file will include the student names. Other information 
fields such as student ID, password, student alias, and pad ID may also be included. 

 

 

 

 

 

 

To export a class roster as text… 

1. Start ExamView Test Manager to open an existing class. 

2. From the File menu, choose Export then Class Roster as Text. 

3. Select the desired export options then click the OK button. 

4. Name the text file and select the save location. 
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Export Roster as CPS Database/Package 
Test Manager allows you to quickly export your class roster as a CPS database 
(Windows only) or CPS package. This ability gives you the flexibility to use the best 
features of ExamView and CPS. 
 

To export a class roster as a CPS Database/Package… 

1. Open an existing class in ExamView Test Manager. 

2. From the File menu, choose Export then Class Roster as CPS Database (Windows 
only) or Class Roster as CPS Package. 

3. Name the database/package file and select the save location. 

• The class information is also exported, including: class name, instructor name, 
school name, city, state, and other optional class information if provided. 

• The roster exports as much of the student information as possible, including: 
student name, student ID, pad ID, gender, ethnicity, and economically 
disadvantaged status. 

• Although an optional field in ExamView, the pad ID assignment is required in 
CPS. If any student does not have a pad ID assigned, an option to automatically 
assign pad IDs will be offered. 

 
4. Click Save. The class file is now available as a native CPS database/package. 
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Create an Assignment 
Before you can score a test, you must first build it using ExamView Test Generator 
and then create an assignment in ExamView Test Manager. When you create the 
assignment, the ExamView Test Manager automatically opens the test file and reads 
the following information for each question (if available): answer, reference, learning 
objective, local standard, state standard, national standard, and points.  

To build a test and create an assignment… 

1. Start ExamView Test Generator, build a test, and save it. 

Automated scoring methods such as scanning or response device transmission only 
work with objective questions such as multiple choice and true/false. If your test 
includes open-ended questions such as short answer or essay, you must manually 
score those questions and record the points. 

Note: If you plan to administer multiple 
(scrambled) versions of a test, create one 
version, print it, and then save the file. 
Scramble the test to create the next version, 
print it, and save the test. For each unique test, 
you must create a separate assignment. 

2. Start ExamView Test Manager and choose to 
open a class. 

3. Click  from the toolbar, choose Create New Assignment from the Assignment 
menu, or click the New Assignment button. 

4. In the New Assignment dialog, enter assignment name, category, term, and date. 

 

 

 

 

 

 

 

 

If your test includes 
objective and open-
ended questions, 
place the objective 
questions (e.g., 
multiple choice) at 
the beginning of the 
test. 
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5. Choose the option(s) to identify how you will administer the test. Click the Next 
button. 

6. Select the file name that corresponds to the test 
you created in ExamView Test Generator. Click 
the Next button. 

 When you click the Next button, the program 
reads the answer key and other information that 
it needs to autoscore the test.  

 Note: If necessary, click the Folder button to 
locate your test.  

7. Review the summary information, and click the Finish button to complete the 
process. 

After you create the assignment, it appears in ExamView Test Manager work area. 
Notice the highlighted area in the figure below. The program shows the assignment 
title, date, category, term, and possible points. A placeholder (--) appears for each 
score. 

You will learn how to get results from various sources in the following sections. 

You can click the 
Preview Test 
button to make sure 
that you are 
selecting the correct 
test. 
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Import an Assignment 
Importing an assignment from another application brings in student responses, points 
earned, correct answers, and some of the question information. Not all question types 
or question information are supported for imported assignments and the questions 
themselves cannot be viewed from within ExamView Test Manager. Aside from these 
limitations, imported assignments appear identical to ExamView-created assignments 
and can be analyzed using ExamView Test Manager's powerful reporting tools. 
 
 
Importing from a CPS Database/Package 
If you use CPS software to collect assessment data, you can import those results and 
analyze the performance using ExamView’s reporting tools. 
 

To import an assignment from a CPS database/package… 

1. Use CPS to collect session data to be used as an ExamView assignment. Save the 
session in a CPS database (“.cps” file) or CPS package (“.cxm” file). 

2. Launch ExamView Test Manager and open the class containing the roster that 
matches the CPS database roster. 

2. From the File menu, select Import then the Assignments from CPS… (Windows) or 
Assignments from CPS Package… (Macintosh) option. The import dialog will appear. 

3. Navigate to the CPS database/package file and click the Open button. The Import 
Assignments from CPS dialog will appear. 

4. Complete Step 1 dialog information, selecting the session data to be imported, and 
click the Next button. 

A. First select the CPS class roster that corresponds to the Test Manager class 
roster. The session data associated with the roster will automatically be listed 
below. 

B. Once the roster is verified, select some or all of the session data listed in the 
dialog. Each session data listing that is selected will import into Test Manager 
as a separate assignment. 

5. Complete Step 2 dialog information, assigning point values, and click the Next 
button 

6. Review the summary information. Click Finish to accept the imported assignments 
into Test Manager. 
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Notes:  

• CPS assigns equal point values for all questions within a session. By default, this 
value is 1 point per question. A different point value may be entered for each 
assignment. 

• Individual question point values can be changed after the assignment is 
imported by editing the assignment information. 

• Student records are matched to the ExamView Test Manager roster based on 
Student ID alone. First name, last name, and pad IDs are not compared. 

• Each assignment can contain a maximum of 250 questions. CPS session data that 
exceed this limit will only import the first 250 questions. 

 
 
Export Assignment Results (WINDOWS ONLY) 
ExamView Test Manager allows you to export your assignment data as formatted text 
files (“.csv”). These files may then be read into many popular gradebook or other 
progress tracking software applications. 
 
 
Exporting for Learning Management Systems 
Using ExamView, you can export student assignment results for ANGEL, Blackboard 
and WebCT Vista. This export feature gives you the flexibility to collect and analyze 
assignment results in ExamView Test Manager and then post them online to your 
Learning Management System. 
 

 
 
 
 

 
 

(Windows only) To export assignment results… 

1. Start the ExamView Test Manager and open or create a class file with at least one 
assignment. 

2. Choose Export from the File menu, and select the target Learning Management 
System. 

3. Complete the export dialog options and click OK to export the assignment results. A 
save dialog will open. 
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4. Set the location where you want to save the exported file, enter a file name, and 
click the Save button. The results will be saved as a “.csv” file. 

5. Login to your LMS and upload the exported assignment results. 

 

 
Exporting Detailed Assignment Results 
In addition to supporting formats for uploading into various LMS platforms, a Detailed 
Results as Text option allows an assignment to be exported with information about 
individual questions (not just overall scores) as well as exporting student demographic 
information (not just name and ID). This export feature is useful for bringing 
assignments into other grade book or data analysis packages. 
 

(Windows only) To export detailed assignment results… 

1. Start the ExamView Test Manager and open or create a class file with at least one 
assignment. 

2. From the File menu, choose Export then Detailed Results as Text. The export 
dialog will open. 

3. Complete the export dialog options and click OK to export the detailed assignment 
results. A save dialog will open. 

4. Set the location where you want to save the exported file, enter a file name, and 
click the Save button. The results will be saved as a “.csv” file. 

5. Login to your LMS and upload the exported assignment results. 
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SCORE PAPER TESTS WITH A SCANNER  

Using the ExamView Test Manager, you can easily score student assignments with a 
scanner. Currently, the program supports the following dedicated OMR scanners: 
Apperson Advantage™ 1200 and the Pearson/NCS EZData® scanner.  

 

Windows Only: In addition to dedicated OMR scanning, with the Windows version of 
the ExamView Assessment Suite you can also use ordinary image scanners to perform 
plain paper scanning to score assignments. 
 

When you use a scanner to score your students’ tests, you… 

• Save time. 
• Get detailed results data. 

 

Saving time is an obvious advantage. Scanner technology makes it easy to score 
multiple choice, multiple response, and true/false 
questions. If a test includes both objective and open-
ended questions, you can score the objective questions 
with a scanner and then manually score the open-ended 
questions, recording the points earned for those 
questions. 

 

The primary purpose of the ExamView Test Manager is 
gathering detailed performance data to help you make 
effective decisions. A scanner provides a means to 
gather the data from paper tests to score your 
students’ work and generate various reports. If your tests include learning objectives, 
state standards, etc., you can then use that information to pinpoint areas where 
individual students need additional help. You can also use that data to identify trends 
for your entire class. 

 

IMPORTANT: 

• You must use specific forms with the scanners. Go to our website 
(www.fscreations.com) for a complete list of supported scanners and forms. 

• You can only score objective questions (e.g., multiple choice, multiple 
response, yes/no, and true/false) using a scanner. However, your test may 
include open-ended questions that you can score manually using the Edit 
Scores option. 

 

A scanner makes 
scoring 
assignments quick 
and easy. And, 
you get detailed 
results for your 
class. 
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Using Bubble Forms for Scanning 
After you create an assignment, the next step is to administer the test and have the 
students fill in their responses on bubble forms compatible with your scanner. 
 

For dedicated OMR scanners, ExamView-specific bubble forms must be used. These 
preprinted forms are ordered from the manufacturer. Refer to the Dedicated OMR 
Scanning section of this guide for details on supported scanner models, form numbers, 
and manufacturer contact information. 

 

Windows Only: With plain-paper scanning, forms are printed directly from a laser 
printer from either the Test Generator or Test Manager. Refer to the Print a Bubble 
Form section in this guide for additional details. 

 

(Windows Only) Plain-paper scanning notes… 

• Plain-paper scanning only supports FSCreations bubble forms. 

• The bubble form must be installed into the copy of Test Manager where the 
results are being scanned. Verify that the form name appears in the list of 
forms displayed in the Print Bubble Form dialog. If the form name does not 
appear, visit the FSCreations website (www.fscreations.com) to download the 
form installer. 

• Forms should be printed on letter sized (8.5” x 11”) white paper at 100% scale, 
in portrait orientation only. Plain paper scanning does not support forms 
printed on other paper sizes, colored paper, or forms that have been scaled or 
printed in landscape orientation. 

• For best results, a laser printer is recommended for printing the bubble forms. 

• Forms must either be printed directly from ExamView or photocopied from an 
original printout. Do not use forms that are photocopied from a photocopy. 

• Verify that the forms are placed properly into the scanner ADF or flatbed. 
Check that the orientation of the image side of the form matches the direction 
specified by the scanner manufacturer. 

• Verify that the bubbles are properly filled in with dark marks and erasures are 
complete. 
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Dedicated OMR Scanning 
Dedicated Optical Mark Recognition (OMR) scanners are designed specifically for 
reading special bubble forms, ordered from the manufacturer. Scanning these forms 
reads the students’ responses for each question, stores this information for each 
student, and automatically calculates their score based on the point values assigned to 
the questions. 
 
The following OMR scanners and forms are currently supported by ExamView Test 
Manager and appear as options in the Get Results from Scanner dialog even if the 
hardware is not available. 
 
Apperson 
Scanner: Advantage 1200 
Forms: 2850, 2851, 2854 
 
Website: www.appersonedu.com 

Pearson/NCS 
Scanner: EZData 
Forms: 258936, 258937, 259402, 259404, 

259405 
Website: www.pearsonncs.com 

 

To get results from a dedicated OMR scanner… 

1. Launch ExamView Test Manager and open the class. 

2. Select (highlight) the assignment that you will be scoring. 

3. Click the  toolbar button, or choose Get Results from Scanner from the 
Assignment menu. 

4. Select the OMR scanner from the drop-down list box. The option to Print correct 
answers on scanner sheet will automatically become enabled if it is a feature 
supported by the selected scanner model. 
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5. Select the connection port to which the scanner is connected, or click Detect 
Scanner to automatically set the port.  

6. Select the form used from the drop-down list box. The list of available forms will 
change depending upon the selected scanner model. 

7. Set the beginning question number and click Next. 

Tip: To save paper, you can reuse the same forms for several assignments. For 
example, you can administer and scan a quiz with 10 questions. For the next quiz, 
set the beginning question number to 11 and have your students fill in the bubbles 
for questions 11-20. 

8. Click Start Scanning to activate the scanning session. 

9. Scan the forms. 

If the student ID on the form does not match an ID in your class roster, the program 
will give you the option to select the student from your roster. 

10. Click Finish to accept the scores and return to the gradebook. 
 
 
General Notes: 

• Verify that the scanner is connected properly before you try to scan the forms. 
If you have trouble with the scanner, contact the manufacturer for support. 

• You may include up to 100 objective questions on a test. If you have more than 
100 questions, divide the test into two parts and create separate assignments.  

• Place the objective questions at the beginning of the test and number the 
questions consecutively (e.g., multiple choice 1-25, true/false 26-40, etc.). 

• If you have a problem with a form, you can make corrections and then re-scan 
it. If necessary, you can manually enter the points earned. 

• You can include matching questions, but the choices are limited to the number 
of choices available on the selected bubble form. Check the form that you 
intend to use to be sure that the number of answer choices matches your test 
questions. Or, you can include matching questions and score the questions 
manually.  

• The software allows you to get results for an assignment from multiple sources. 
For example, you could administer a paper test to part of the class and an 
online test to other students. 

• You can scan forms in multiple sessions.  
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• If there are problems with a student’s form—missing responses, multiple 
responses, out of range (e.g., entering an E if only A-D valid), etc.—an asterisk 
(*) will appear next to that student’s name. Click the Stop Scanning button, 
highlight the student’s name, and click the Edit button. You can change the 
response for any item. Click the Start Scanning button to continue. 

 
 
Apperson Advantage 1200 Notes: 

• If the scanner becomes unresponsive, click the Stop Scanning button, press the 
Reset Options button (located on the scanner), and then click the Start 
Scanning button. If that does not solve the problem, cancel the scanning 
process. Turn the scanner off; turn the scanner on; and try to scan the forms 
again. 

• The Apperson scanner prints the percentage score on the scanner form. For tests 
with only objective questions all set to 1 point, the score will be correct. If your 
test includes open-ended questions, the score printed on the form will not 
reflect the open-ended questions. Unfortunately, there is no way to turn off 
printing. However, you can remove the print cartridges. 

 
 
Pearson/NCS EZData Notes: 

• If the status light turns an orange color, contact the manufacturer for 
assistance. A problem may occur if there is a conflict between the scanner and 
another hardware device. 

• If you notice that the information is regularly misreading student responses, 
follow the manufacturer’s guidelines for cleaning the scanner. 
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Plain-Paper Scanning (WINDOWS ONLY) 
Plain-paper scanning allows you to print bubble forms using an ordinary laser printer 
and scan the results using a TWAIN-compliant image scanner. Because forms can be 
printed on-demand on standard sheets of paper, plain-paper scanning provides great 
flexibility, convenience, and cost savings over dedicated OMR scanning. Additionally, 
the hardware required for plain-paper scanning can be used for other purposes.  
 
Plain-paper scanning reads the students’ responses for each question, stores this 
information for each student, and automatically calculates their score based on the 
point values assigned to the questions. 
 
IMPORTANT: 

• See our website (www.fscreations.com) for a list of image scanners that have 
been validated for compatibility with the plain-paper scanning feature. 

• Although not required, it is strongly recommended that the scanner is equipped 
with an automatic document feeder (ADF) in order to be an effective tool for 
plain paper scanning. 

 

(Windows only) To get results from a plain-paper scanner… 

1. Launch ExamView Test Manager and open the class. 

2. Select (highlight) the assignment that you will be scoring. 

3. Click the  toolbar button, or choose Get Results from Scanner from the 
Assignment menu. 

4. Select the desired scanner from the drop-down list box. 

A separate entry will appear for every imaging device with TWAIN drivers installed 
on the computer. Some scanner manufacturers will install multiple drivers for a 
scanner, so multiple entries will appear in the list for a single scanner. Try to 
select the entry for the scanner that is most appropriate for the model and 
connection of your scanner. 

Tip: With plain-paper scanning, there is no need to specify a form and an 
assignment does not have to be answered using the same form for all students. For 
example, you can administer a 50 question multiple choice test with most of the 
class using form FSC50AE, but give students with special needs form FSC50AE Jr. 
There is no need to sort the forms or specify which forms are being used. The form 
information is automatically read in from each sheet as it is scanned. 

5. Set the beginning question number and click Next. 
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Tip: To save paper, you can reuse the same forms for several assignments. For 
example, you can administer and scan a quiz with 10 questions. For the next quiz, 
set the beginning question number to 11 and have your students fill in the bubbles 
for questions 11-20. 

6. Load the forms into the scanner ADF tray or flatbed. 

Forms may be rotated 180 ۫ from each other but must be placed with the image sides 
properly facing the scanning surface. Check that the orientation of the image face 
of the forms matches the direction specified by the scanner manufacturer. 

7. Click Start Scanning to initiate session. 

8. Scan the forms. 

If the student ID on the form does not match an ID in your class roster, the program 
will give you the option to select the student from your roster. 

9. Click Finish to accept the scores and return to the gradebook. 

 
Notes: 

• Verify that the scanner is connected properly before you try to scan the forms. 
If you have trouble with the scanner, contact the manufacturer for support. 

• If you have more questions than can be accommodated on a form, divide the 
test into two parts and create separate assignments.  

• Place the objective questions at the beginning of the test and number the 
questions consecutively (e.g., multiple choice 1-25, true/false 26-40, etc.). 

• If you have problem with a form, you can make corrections and then re-scan it. 
If necessary, you can manually enter the points earned. 

• You can include matching questions, but the choices are limited to the number 
of choices available on the selected bubble form. Check the form that you 
intend to use to be sure that the number of answer choices matches your test 
questions. Or, you can include matching questions and score the questions 
manually.  

• The software allows you to get results for an assignment from multiple sources. 
For example, you could administer a paper test to part of the class and an 
online test to other students. 

• You can scan forms in multiple sessions.  

• If there are problems with a student’s for—missing responses, multiple 
responses, out of range (e.g., entering an E if only A-D valid), etc.—an asterisk 
(*) will appear next to that student’s name. Click the Stop Scanning button, 
highlight the student’s name, and click the Edit button. You can change the 
response for any item. Click the Start Scanning button to continue. 
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SCORE PAPER TESTS WITH CPS RESPONSE PADS  

Using ExamView Test Manager, you can easily administer paper tests and score them 
with Classroom Performance System (CPS) response pads. 

 

When you use response devices to score your students’ tests, you… 

• Get instant, real-time results. 
• Engage students with technology. 

 

Similar to scanning results, response pad technology makes it easy to automatically 
grade most objective questions (e.g., multiple choice, yes/no, and true/false). If a 
test includes both objective and open-ended questions, you can score the objective 
questions with the response pads and then manually grade and record the points for 
the open-ended questions later. Using response pads has the added advantage of 
engaging students with technology. Entering and transmitting answers with response 
pads is fun and easy! 

 

 

About the Hardware 

Supported Response Pads 
Test Manager supports using CPS response pads to 
transmit student results directly into the gradebook. 
Supported response pads include both the infrared and 
Gen2 radio frequency systems. Currently, only numbered 
sets of pads (K-12) can be used with ExamView. 
Individual, serial numbered pads (Higher Ed.) are not 
supported at this time. 

 

 

About the IR System 
Each IR receiver unit supports up to 60 pads and under optimal conditions can accept 
signals up to 60 feet away. Students must have a direct line-of-sight to successfully 
transmit to a receiver and when under heavy use, may experience signal interference 
that requires re-sending their response. 

 

Students transmit their responses by simply pressing a button on the pad. A feedback 
grid should be projected to the class to allow students to verify that their results have 
been successfully received. 
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About the Gen2 RF System 

Each RF receiver unit supports up to 300 pads in K-12 mode and has a range of 200 
feet. Unlike the IR system, RF pads are not limited to line-of-sight transmission. 
Because of its large range, it is important that each classroom use a different channel 
number to prevent communication problems. Pads and receivers are programmed by 
eInstruction to a specific channel number and care should be taken not to mix the 
pads from different sets. The channel number is displayed on the receiver in bright red 
when powered by a USB connection. Access the summary screen to display the channel 
number programmed for the pad. 

For example, this summary screen shows that pad ID 3 
(0003) is programmed to communicate on channel 
number 15 (CH:15). Notice that the lower right of the 
screen must show K12 (not HE) to work with ExamView.  

Students may enter responses up to 12 characters in length which include letters A-J, 
numbers, and symbols (+, -, *, /, X, Y, parentheses, decimal, space). Because of its 
multi-character support, students must always press the Send button on the pad when 
they are ready to transmit their answer. It is important that students verify that all of 
their answers have been received. In Teacher-Led Student-Managed sessions, the 
projected feedback grid changes color when responses are received. For Student-
Managed sessions, the pad’s LCD screen displays a RECV’D message. 
 

To check the channel number on the Gen2 RF pad… 

1. Start with the pad powered off. 

2. Press and hold down the Power/Join button. The pad and serial numbers will be 
displayed. 

3. While continuing to hold the Power/Join button down, press and hold down the 
right arrow (>) button. 

4. Continue to hold both buttons down for several seconds then release both buttons. 

5. Press the left arrow (<) button. The summary screen should now appear. 

6. Note the channel number (CH:#). Press the Send button to return the pad to 
normal function. 
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Assigning CPS Response Pad IDs 
In order to correlate the transmitted data with student records, response pad IDs must 
be assigned to students. 

 

To assign a response pad ID… 

1. If the Student Information window is not already open, double-click the student 
you want to edit. Or, highlight the student and choose Edit Student Information 
from the Student menu. 

2. Enter the response pad ID number in the field labeled Pad ID. To assign pad IDs to 
additional students, choose the student you wish to edit from the list on the left or 
click the Previous or Next buttons. 

3. When you are finished assigning pad IDs to students, click Done. 
 

Notes: 

• Pad ID values are limited to numbers ranging from 1 to 1000. 

• Although pad IDs are an optional student information field, values must be 
unique within the class file. In other words, the same pad ID cannot be 
assigned to more than one student in the same class. 
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Get Results from CPS Response Pads 
After you create the assignment, hand out the paper test and response pads and start 
the response pad session to get the student results directly into ExamView Test 
Manager. 

 

To get results from CPS response pads… 

1. Launch ExamView Test Manager and open the class. 

2. Select (highlight) the assignment that will be used in the response pad session. 

3. Click the  toolbar button, or choose Get Results from then CPS Response Pads 
from the Assignment menu. 

4. Test Manager searches for eInstruction receivers attached to the computer then 
opens the Get Results from CPS Response Pads dialog. All detected receivers are 
automatically shown by their COM port in the Connection pull-down list. 

5. Select the Session Delivery Mode using the pair of radio buttons. 

Student-Managed: Students work in a self-paced mode. At any given time students 
may be responding to different questions on the test. Depending on the hardware 
system, the session will either open with a student feedback grid that must be 
projected (IR) or an instructor feedback window that shows transmitted results in 
real-time (RF). 

Teacher-Led Student-Managed: The instructor controls the pace of the assessment 
and leads the class through each question. For both IR and RF systems, a student 
feedback grid must be projected for the session. 
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6. Session settings may be verified or adjusted by clicking the Sessions Settings 
button. 

7. Click the OK button to close the dialog and open the response pad session window. 

 

Notes: 

• Verify that the receiver is connected properly before opening the Get Results 
from eI Response Pads dialog. Click the Refresh List button if the receiver does 
not appear in the Connection pull-down list. 

• Some older models of the IR receiver require manual detection. Click the 
Manual Detection button and follow the dialog instructions. 

• Although CPS is not required for the pads and receivers to work with ExamView, 
a USB-to-serial driver needs to be installed. If the receiver continues to fail 
detection, try to reinstall this driver. Visit the eInstruction website 
(www.einstruction.com) to download the latest version of this driver. 

 
 

 

Student-Managed Sessions with IR Pads 
Student-Managed IR sessions allow students to work at their own pace. Unlike Student-
Managed RF sessions, these sessions require that a projector is used to display a 
feedback grid. When the feedback grid opens, the main gradebook window is hidden 
from view to prevent scores from being projected to the class. 
 
The feedback grid includes a box for each student, the top half of each box shows the 
pad ID number and the bottom half shows the current question number for that pad. 
The numbers combined with color changes allow students to monitor their progress.  
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IR Student-Managed feedback grid: 
 
 

Feedback grid top numbers 
correspond to pad IDs, 
bottom numbers show the 
current question number for 
that pad. Notice how each 
student works at their own 
pace. 

 

 

 

 

A summary of the feedback grid color meaning is shown below. 

 

Dark Gray/Gray = Disabled 
Session has not yet begun. All pads are 

completely disabled. This example shows 

the box for pad ID 3 waiting to answer 

question 1. 

 

 

 

Blue/Gray = Unsupported Question 
If the option to show unsupported questions 

is selected in the session settings, questions 

that cannot be answered with the response 

pads will appear with the blue/gray color 

combination. Studenst must use the arrow 

buttons to navigate past this question. 

 

 

Light Blue/White = Ready for Response 
Session is active. In this example, 

student with pad ID 3 should answer 

question 1. 

 

 

Blinks Green = Same Response 
The green color flash indicates that a new 

response has been received for the question, 

but it is the same as the previously recorded 

response. 

 

 

Blue/White = Question Answered 
The top half (pad ID) turns blue when a 

question (bottom number) is answered. 

In this example, question 1 has been 

answered by pad ID 3. 

 

 

 

Blinks Yellow = Different Response 
The yellow color flash indicates that a new 

response has been received for the question 

and it is different from the previously 

recorded response. 

 

 

Blue/Blue = All Questions Answered 
The bottom half (question number) turns 

blue when all questions are answered for 

a particular pad ID. In this example, pad 

ID 3 has answered all questions and is 

currently on question 10. 

 

 

 

Blinks Red = Out of Range Response 
The red color flash and “X” display indicates 

that a response is out of range for the 

question. For example, “E” is answered for a 

multiple choice question with choices A-D. 

Out of range responses are ignored and the 

question number is not advanced. 
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Student-Managed Sessions with RF Pads 
Student-Managed RF sessions allow students to work at their own pace and do not 
require a projector to display a feedback grid. Students use the pad LCD to track 
which question they are on and when a response has been received. Because answers 
may include multiple characters, students need to press the Send button at the end of 
every response to signify that the answer is complete. Questions that have been sent 
will display a RECV’D message on the LCD. See the example screens below. 

 
While students use their pad LCD to track their individual progress, instructors monitor 
the class progress through the Get Results from CPS Response Pads session dialog. 
The session dialog is not projected and shows the student results in real-time as they 
are transmitted to the receiver.  

 
Scores are shown in either points or percentages, depending on the display settings for 
the main gradebook. 
 
 
Teacher-Led Student-Managed Sessions 
Teacher-Led Student-Managed mode has the teacher set the pace of the response pad 
session and is especially appropriate for younger grades. The mechanics of this session 
are the same for both IR and RF pads. A typical scenario for this mode would be to 
administer an assessment in the traditional fashion using paper and pencil. At the end 
of the test period, the teacher starts the response pad session, projecting the 
feedback grid and leading the class through the process of transmitting their results. 
The feedback grid displays each pad ID in a box that changes color when the student 
transmits a response.  
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Teacher-Led Student-Managed feedback grid: 

 
 
Feedback grid numbers 
correspond to pad IDs. Notice how 
all students are responding to the 
same question. The instructor 
uses the arrow buttons (or arrow 
keys on the keyboard) to change 
the question number. 
 
 
 
 
 

 
Click the arrow buttons or use the arrows on the keyboard to change the question 
number displayed to the class. 
 
A summary of the feedback grid color meaning is shown below. 

 

Gray = Disabled 
Session has not yet begun. All pads are 

completely disabled. This example shows 

the box for pad ID 3 waiting to answer 

question 1. 

 

 

 

Blinks Green = Same Response 
The green color flash indicates that a new 

response has been received for the question, 

but it is the same as the previously recorded 

response. 

 

 
White = Ready for Response 
Session is active. In this example, 

student with pad ID 3 should answer 

question 1. 

 

 

Blinks Yellow = Different Response 
The yellow color flash indicates that a new 

response has been received for the question 

and it is different from the previously 

recorded response. 

 

 
Blue = Question Answered 
The top half (pad ID) turns blue when a 

question (bottom number) is answered. 

In this example, question 1 has been 

answered by pad ID 3. 

 

 

 

Blinks Red = Out of Range Response 
The red color flash and “X” display indicates 

that a response is out of range for the 

question. For example, “E” is answered for a 

multiple choice question with choices A-D. 

Out of range responses are ignored and the 

question number is not advanced. 
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ADMINISTER ONLINE TESTS ON YOUR LOCAL AREA NETWORK  

The ExamView Assessment Suite includes all of the tools you need to create and 
administer online tests on your local area network (LAN). Use the online testing 
features to save time grading tests and generate the information to improve student 
performance. 

You can create online tests that anyone can take using your local area network (LAN), 
or you can assign a roster to an online test. For example, you can use ExamView Test 
Generator to create self-grading practice tests (or study guides) that provide feedback 
for incorrect responses. You can also use this testing option to administer chapter 
tests, quizzes, benchmark tests, homework, and worksheets. Then, use ExamView 
Test Manager to get results from an online test and produce reports. 

 

Before You Begin  
Before students can take tests using your local area network (LAN), you must get ready 
for online testing.  

1. Talk to your network administrator to secure space 
on your local area network to put the online tests. 

You and your students both need read/write (full) 
access to the network folder. 

2. Ask your network administrator to install the 
ExamView Test Player on your network and to place 
a shortcut on each workstation to access the 
program. Or, you can install the player program on 
each computer. 

 (Windows only) Advanced: You can create a shortcut for the program and set the 
target properties to include the following options. For example, set the target to 
c:\examview\evpro.exe /nobrowse. 

 /nobrowse This option turns off the option for students to change the path 
(or location) of the tests. 

 /noprefs This option directs the program not to write the preferences to 
the local computer. 

 /testpath= This option allows you to set the default path for the tests. 

3. Start ExamView Test Generator, choose Preferences from the Edit menu and click 
the Files icon. Set the default online (LAN) path to the location on the network.  

Talk to your 
network 
administrator to 
get everything 
set up before you 
publish an online 
test. 
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Create an Online (LAN) Test without a Roster  
You can publish an online test with or without a roster for your students to take on 
your local area network (LAN). If you choose to publish a test without a roster, the 
program automatically scores the test. Anyone may take the test; however, the results 
are only available immediately after a student completes a test. No results are stored 
in ExamView Test Manager, and you will not be able to prepare any student/class 
reports. 

To create and publish an online (LAN) test that anyone can take… 

1. Start ExamView Test Generator and create or open 
a test. 

2. On the File menu, point to Publish To, and then 
click ExamView Test Player on LAN. 

3. Select Allow access to anyone and click Next.  

4. Enter a test title and follow the steps to set the remaining options (i.e., password, 
question order, number of questions, student feedback, and reports) for the online 
test. 

 The program provides numerous options that allow you to customize the online 
testing experience for your students’ needs. Click the Help button to view detailed 
information about the online testing options. 

Results are not 
stored for online 
tests without a 
roster. These 
tests are great 
for practice tests 
and homework. 
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5. Review the test summary information and click the Save button to save the online 
test to your local area network (LAN). 

  

 

 

 Note: When you save the online test, the program saves a specially formatted copy 
of the test (with an “.eot” extension) to the location you specified. Remember that 
your students must access the test file on the local area network (LAN). If you saved 
the test to your hard drive, you must copy the online test (“.eot”, not “.tst”) to 
your network. 

6. If your test includes links to any multimedia files, you must copy those files 
manually to the same location as the online test. 

Students can now take the online test. See the Take a Test with the Test Player 
section. 

IMPORTANT: Preview the online test to make sure that everything is working. If you 
notice an error, make changes to the original test and publish it again. 

You can set the 
default folder 
using the 
Preferences 
option in the Edit 
menu. 
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Create an Online (LAN) Test with a Roster  
With the ExamView Assessment Suite, you can easily track student test results. When 
students take an online test, the program automatically scores the objective questions 
and stores the information in a database. Then you can produce a variety of reports 
and/or copy the results to your gradebook. 

 
To create an online test with a roster, you must first build and publish the online test 
using the ExamView Test Generator. Then, you must complete the process by 
creating an assignment in the ExamView Test Manager program. 

To create a test, publish the test, and track results for selected students…  

1. Start the ExamView Test Generator and create or open a test. 

2. On the File menu, point to Publish To, and then click ExamView Test Player on 
LAN. 

3. Choose Limit access to students in a particular class and click Next. 

 

 

 

 

 

 

 

 

4. Select the Launch ExamView Test Manager after publishing online test checkbox 
and click Save to save the online test. 

 Note: When you save the online test, the program saves a copy of the test (with an 
“.eot” extension) to the location you specified. Remember that your students must 
access that location on the local area network (LAN). If you saved the test to your 
hard drive, you must copy the online test (the “.eot” file, not the “.tst” file) to 
your network. 

5. If your test includes links to any multimedia files, you must copy those files 
manually to the same location as the online test. 

If you include 
open-ended 
questions, it is 
easy to score 
student responses 
manually. 
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To assign an online test to a class… 

1. Start the ExamView Test Manager (if necessary). 

 After you publish an online test, you must complete the process by creating an 
assignment for that class. 

2. Open a class file. 

3. Click  or choose the Create New Assignment option from the Assignment menu. 

4. Enter the assignment name, category, term, and date. 

5. Choose the Online test delivered over a local area network (LAN) option to 
identify how you will administer the test. Click the Next button. 

6. Select the file name that corresponds to the test you published in the ExamView 
Test Generator. 

7. You can allow your students to complete the test multiple times or over multiple 
sessions. Select the appropriate option(s) and click the Next button. 

 If you allow students to complete an online test over multiple sessions, the program 
will save their work and let them continue where they left off in a prior session. 

Select an ExamView 
online test (.eot), 
not a regular test 
(.tst) file name. 
 
You can preview a 
test to make sure it 
is the right one. 
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8. Follow the steps to set the remaining options (i.e., password, test date, time limit, 
question order, student feedback, and reports) for the online test. 

 The program provides numerous options that allow you to customize the online 
testing experience for your students’ needs. Click the Help button to view detailed 
information about the online testing options. 

 

 

 

 

 

 

 

 

9. Review the summary information and click the Finish button. 

After you create the assignment, it appears in the ExamView Test Manager work 
area. Notice the highlighted area in the figure below shows the assignment title, 
date, category, term, and possible points.  A placeholder (--) is set for each 
student’s score.    
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10. You should preview the online test to make sure that the test itself and online 

settings are correct. 

IMPORTANT: To preview a test with a roster, start the EV Test Player and use one 
of your student’s IDs to take the test. When you finish, go to the ExamView Test 
Manager. Open the class file, select the assignment, and choose the Get Results 
from a LAN Test option. You should see the score for that student. Next, highlight 
(select) the student record and choose Clear Student Results from the Student 
menu. Be sure to clear the results for only the test you just previewed. Be sure to 
choose the Update Online Tests option in the File menu to apply the updates to the 
online test. 

 

Notes: 

• You can assign the same online test to multiple classes. Simply open another 
class file and create an assignment. Point to the same online test when you 
create the assignment. Make sure that your students’ IDs are unique across all 
classes. 

• If you need to make any changes to the online settings (e.g., change the 
password, edit the reporting options, etc.), choose the Edit Assignment 
Information option from the Assignment menu.  

• If you notice mistakes in questions, misspelled words, etc. before any students 
take a test, make your changes to the original test and publish it again. 
IMPORTANT: You must delete the assignment from the class and then create a 
new one.  Otherwise, the answer key and other information will not match the 
online test. 

• If you notice mistakes in questions, misspelled words, etc. after any students 
take a test, you cannot make changes to the test. However, you can adjust the 
points earned to adjust students’ scores as needed. 

• If you identify an incorrect answer or point value, choose the Edit Assignment 
Information option from the Assignment menu. Click the Questions tab and 
change the information. You can change an answer or point value anytime 
without re-publishing the test.  These changes are not updated in the actual 
test, but they are applied to the students’ results. 
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Take a Test with the Test Player 
For tests that you administer on your local area network (LAN), students must use the 
ExamView Test Player to take the test. Before your students can take the test, make 
sure that the program is installed on your network and that students have read/write 
(full) access to the folder where the test is located. 

You can include any question type (multiple choice, true/false, numeric response, 
completion, essay, etc.) on an online test. The program automatically scores any 
objective (e.g., multiple choice), completion, or numeric response questions. You must 
manually score any open-ended (e.g., essay) questions as described in the next 
section—Get Results from a LAN Test. 
 

To take an online test… 

1. Start the ExamView Test Player program. 

2. Enter the student name and ID. Click the Next button to continue. 

 

 

 

 

 

 
 
 
 
 
 
 

3. Select the test and click the Next button. 

If you do not see the test listed, click the Folder 
button to change the location (if necessary). The 
program will show only those tests that the student 
may access. For example, if you set a date range 
when the test is available, you will not see the test if 
the current date is not in that range. 

If a student 
enters their ID 
incorrectly, no 
tests will appear 
in the list. 
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4. Review the test information and click the Start button to begin the test. 

 The ExamView Test Player displays one question at a time. Students can answer a 
question by clicking the radio buttons, clicking the choice buttons, or by typing a 
response. 

 

 

 

 

 

 

 

 

 

 

 The options available to the student depend on the online settings. For example, if 
you set the option to allow students to check their work, the Score button appears 
at the bottom of the window. If you set a time limit, a timer is displayed.  

 Get in the habit of previewing a test to make sure that you selected the appropriate 
settings. 

5. Respond to each question. Click the Next button or 
press Page Down to go to the next question. 

6. Click the End button when you are finished. 

 Depending on the reporting options you set, a report 
will appear.  

7. Click the Exit button to quit the program, or click 
the New button to start a new test.    

You can set an 
option to show 
the end-of-test 
report and 
whether students 
can print the 
report. 
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Get Results from a LAN Test 
After your students take an online test, the next step is to get the results into the 
ExamView Test Manager. When you perform this step, the program reads the results 
and stores the data in the class record. If your test 
includes open-ended questions, you must manually score 
the questions and record the points earned. 

To get results from a LAN test… 

1. Start the ExamView Test Manager program. 

2. Select (highlight) the assignment for which you want 
to get results. 

3. Click  or choose the Get Results from LAN Test option from the Assignment 
menu. 

The program automatically locates the online test file (with an .eot extension) and 
reads the results from it. If you moved the file, you must locate it. 

4. If your test included open-ended questions or you need to change a student’s score, 
select the assignment and choose the Edit Scores option from the Assignment 
menu.  

 The Edit Test Scores window shows you how your students answered each question 
and the points earned. Select a student. For open-ended questions, select a 
question. The student’s response appears for your review. Read the response and 
enter the points earned. Click the Next button to move to the open-ended question 
for the next student. You can change the points earned for any other question too. 

  

 

 

 

 

 

 
 

 

Remember, that 
student results 
are stored only 
for online tests 
that you assigned 
to a class. 
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PUBLISH A TEST TO THE LEARNING & TEST CENTER  

Using ExamView Test Generator, you can publish an online test in several ways. One 
of those ways is to publish a test/assignment directly to an Internet test-hosting 
service called the Learning & Test Center. A test-hosting service offers these 
advantages: (1) publish to the Internet with just a few mouse clicks; (2) results 
tracking and reporting; (3) control over when and who takes a test; and (4) no 
additional hardware or maintenance costs. 

FSCreations, Inc. (the developers of the ExamView Assessment Suite) offers an 
optional test-hosting service on an annual subscription basis. For more information and 
pricing, visit our website at www.fscreations.com. 

With the Learning & Test Center, you can… 

• Publish a self-grading practice test in just a few steps that your students can 
take from anywhere they have access to a computer and the Internet. 

• Administer homework and automatically score it without any additional effort 
on your part. 

• Deliver benchmark tests to a class or an entire school. 
• Produce numerous reports that let you track student performance by standard. 

Other companies may offer an online service. Check with your sales representative 
or visit their website for more details. If you do have access to a publisher service, 
follow the steps below except choose the appropriate service from the Publish To 
menu option.  

IMPORTANT: You will not use the ExamView Instructor Center or Learning & Test 
Center to administer tests published to another service.  

 

Register for the Learning & Test Center 
Before you use the ExamView Learning & Test Center, you must purchase a 
certificate number and then use it to register for an account. When you register, you 
receive an instructor ID and a password. 

To register for an account… 

1. Visit www.fscreations.com/examview.php and click the 
Instructor Center link. 

2. Click the Register link and follow the instructions to sign up 
for the service. 

Be sure to record your instructor ID and password. You will 
also receive an email with this information. 

3. Quit the browser when you finish. 

After you register 
online at the 
FSCreations 
website, you can 
change your ID 
and/or password. 
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Publish a Test or Assignment 
Publishing a test/assignment (regular or self-scoring) to the ExamView Learning & 
Test Center is a very simple process. Within minutes, you can create a test or an 
assignment for students to take online. Test or homework results are available 
immediately after your students complete the assignment. 

To publish an assignment… 

1. Start the ExamView Test Generator, and create or 
open a test. 

2. On the File menu, point to Publish To, and then 
click ExamView Learning & Test Center. 

3. Enter a title for the test/assignment. 

4. Enter your instructor ID and password, and then click 
the Next button. 

5. Select the option to determine who may access the test. 

You can allow anyone to take the assignment or control access to students in a 
particular class. If you do not care about getting student results or how many times 
a student completes an assignment, allow access to anyone. 

If you want to track your students’ results, you must assign a class. You can create a 
roster or import student names and IDs from another file. 

6. Set a password for the assignment and click the Next button. 

If you have an 
account with 
another service, 
select it from the 
Publish to: pop-
up and enter the 
appropriate ID 
and password.  
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7. Select the remaining online options.  

8. Review the summary information, and click the Publish button to upload the 
assignment to the website. 

After you publish the assignment, you will receive an email that confirms you 
published the assignment successfully. The email also includes instructions that you 
can provide to your students. 

 

 
Access the ExamView Instructor Center 
The ExamView Instructor Center provides access to tests you publish via the test-
hosting service. Access the Instructor Center using a web browser on any computer 
connected to the Internet.  

Using the ExamView Instructor Center, you can… 

• Preview a test/assignment. 
• Change selected test settings. 
• Edit, change, or delete students. 
• Access numerous student reports. 
• Delete tests. 
• Update your account information (ID, password, email address, etc.). 

 

After you publish 
an assignment, 
you can preview 
it and edit many 
of the settings 
online at the 
Instructor 
Center.  
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To access the ExamView Instructor Center… 

1. Go to the www.fscreations.com website. 

2. Click the Instructor Center link. 

3. Enter your instructor ID and password to log in to the Instructor Center. 

4. Link to the desired option to manage tests, view reports, update account 
information, etc. 

 

 

 



 

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 72   

Complete a Test/Assignment via the Internet  
Students can take a test or complete an assignment using any computer (Windows or 
Macintosh) connected to the Internet (e.g., at school, in a 
lab, or at home). When you are ready for students to work 
online, direct them to the www.evtestcenter.com website.  

To take an online test or complete an assignment… 

1. Go to the www.evtestcenter.com website. 

2. Enter the Instructor’s ID. 

After you log in, you will see a list of the available 
tests/assignments. 

3. Highlight an item and click the OK button. 

4. Enter the student ID or name, and enter the password. 

IMPORTANT: If you published a test/assignment with a roster, your students must 
enter the ID you assigned to them. If you allowed anyone to access the assignment, 
students must enter their name. 

5. Complete the test/assignment. Click  to submit and/or view the 
results. 

When you publish 
an assignment, 
you get an email 
with a link to the 
test. Students 
can use that link 
to skip the log in 
process.  
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Get Results from an Internet Test/Assignment 

Using the ExamView Test Manager you can download results from the Instructor 
Center to your desktop. Then, you can produce reports using the reporting options 
provided in the ExamView Test Manager. You can combine results from all of your 
assignments (paper, LAN, or Internet) into one convenient location. 

Before you can download the results, publish your test/assignment with the ExamView 
Test Generator using the various online settings described in the previous sections. 
Administer the test or homework assignment to your students. 

IMPORTANT: Getting the results from an Internet test is optional since you can access 
many reports online at the ExamView Instructor Center. With the test-hosting 
service, you can view student results and generate numerous reports online. You do 
not have to download the results into the ExamView Test Manager. 

To get results from an Internet test/assignment… 

1. Publish and administer a test/assignment to the Learning & Test Center. 

2. Start the ExamView Test Manager (if necessary) and open a class.  

3. Create an assignment if you have not already done so. Enter the assignment 
information and identify the test (.tst) for the program to read the answer key and 
other question information (standards, references, etc.). 

4. Highlight the assignment. Click  or choose Get Results from Internet Test. 

5. Enter your instructor ID and password, and click Next. 

6. Select the Internet test from the list provided and click Finish to get the results. 

 The ExamView Test Manager downloads all of the students’ responses and results 
from the Internet test-hosting site. If your test includes open-ended questions or 
you need to change a student’s score, select the assignment and choose the Edit 
Scores option from the Assignment menu. 

 

Notes: 

• When you publish an assignment, be sure to save a copy locally on your 
computer. The assignment you publish online must match exactly the one you 
use to create an assignment in the Test Manager. 

• You can administer a test using any combination of paper, local area network 
(LAN), or Internet testing options. 

• Unlike tests administered via a LAN, you cannot change the settings in the 
ExamView Test Manager. You must make any changes to these settings and the 
class roster online at the Instructor Center.  



 

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 74   

PREPARE REPORTS FOR PAPER AND ONLINE TESTS  

The ExamView Test Manager enables you to prepare a variety of reports based on 
your students’ assignment results data. You can print a report for a single assignment, 
a group of assignments, or all assignments. You can also easily customize a report to 
include selected students filtered by various criteria. Many of the reports include 
graphs and charts that provide a visual analysis of the data. 

 

Use the ExamView Test Manager to generate the following class and reports. 

 

Class Reports 
Assignment Results 
Class Assignment Summary 
Open-Ended Responses Worksheet 
Item Analysis Summary 
Item Remediation Summary* 
Class Roster 
Learning Focus 
Performance Summary 
Class Performance Progress Chart 
 

Student Reports 
Assignment Results 
Assignment Review 
Student Progress Report 
Learning Focus 
Performance Summary 
 

  

For each report, you can choose reporting options to control the information included 
in the report. Using the filter option, you can generate reports for selected students or 
a group of students that match the criteria you set.  
 
 
Class Reports 
The ExamView Test Manager provides numerous reports to help you understand and 
evaluate your students’ performance. Depending on your needs, you may prepare one 
or more of the class reports to provide useful performance data that allows you to 
assess your class as a whole and then determine appropriate strategies to achieve the 
learning objectives/standards. With each report, you can control numerous reporting 
options to customize the report as desired. This section includes a brief overview and 
a sample of each class report. 
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Assignment Results 
The Assignment Results report provides performance data for each student for a 
particular assignment. The report includes the student’s name, ID, points earned, and 
percentage achieved. For online test, the report also includes attempts to complete 
the assignment, the start time (date and time), and the duration of the assignment 
(i.e., the total time to complete the assignment).  

 

The report also includes a separate page with the assignment statistics for the entire 
class (i.e., median, mean, low score, high score, range, and standard deviation) and a 
graph of the frequency distribution. When you choose this report, you can control 
various reporting options. For example, you can choose to show all of the student 
information or you can include the ID or alias for each student.  

 

Using the statistical data in the Assignment Results report, you can see how the 
majority of the students performed on the assignment. The duration data provides 
useful information for future reference; you can calculate the approximate amount of 
time required for the students to complete the assignment. Finally, you might use the 
Assignment Results report to post the results of an assignment. 
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Class Assignment Summary 
The Class Assignment Summary report provides the average for each student for all 
assignments or for a particular category (i.e., tests, quizzes, etc.) of assignments. You 
can summarize the data for all terms or one term. For example, you can create a 
report that shows each student’s average for all tests in the first term.  

 

Over time, the Class Assignment Report provides useful data to help you assess the 
performance of your class as a whole. From this information, you might be better 
equipped to assess the effectiveness of your teaching strategies and the associated 
assignments as they relate to the learning objectives/standards for the class.  

 

Note: In the Class Assignment Summary report, the shaded area ( ) shows the 
median performance range for the class and the diamond ( ) shows the exact student 
average. 
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Open-Ended Responses Worksheet 
The Open-Ended Responses Worksheet report allows you to score the open-ended 
questions that your students complete as part of an online test. Follow these steps to 
score open-ended questions and enter the scores into the ExamView Test Manager. 

 

1. After all of your students finish an online test, use the option to get the results 
into the ExamView Test Manager. This process reads all of the student responses 
for the assignment including the open-ended questions (essay, short answer, etc.). 

2. Print the Open-Ended Responses Worksheet. The report includes the open-ended 
responses for each student and space for you to write the points earned for each 
question.  

3. After you complete the worksheet, use the Edit Scores option to enter the results 
into the program. 

 

You can use the Open-Ended Responses Worksheet report to work away from your 
computer. You can score open-ended questions anywhere and then enter the scores 
into the ExamView Test Manager at a convenient time. 
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Item Analysis Summary 
The Item Analysis Summary report provides the percent of the class that answered 
each question correctly. For multiple choice questions, the report also shows the 
percent of the class that selected each response (or answer choice).  
 
You can use the response analysis in the Item Analysis Summary to identify areas in 
which you may want to focus a re-teaching activity so that you can better address 
particular learning objectives/standards. For questions with a high, correct response 
rate, you can use the information to validate the question. On the other hand, if 
students consistently answered a question incorrectly, you can assess whether this 
points to a problem with the question. For example, suppose students answered a 
question overwhelmingly (e.g., 60%) with an incorrect response. This may have 
occurred because you recorded an incorrect answer for the question, the question was 
unclear, or you did not cover the information adequately in class. 
 
If, in a particular multiple choice question, the student responses are evenly 
distributed for all of the answer choices, the analysis may indicate that students 
randomly selected a response. If, in another multiple choice question, students 
selected the correct response at 65% followed by 30% for the next response. This 
response analysis data may point to a common mistake students made in determining 
the correct answer for the question. On a question-by-question basis, you should look 
for similar patterns; such information can provide insight into your students’ 
understanding of the material covered by the assignment.  
 
Note: In the Item Analysis Summary report, a warning icon appears next to any 
question answered incorrectly by a percent of the class that is greater than the 
threshold level. 
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Item Remediation Summary 
The Item Remediation Summary report provides a summary of questions that the 
class answered incorrectly at a rate higher than the set threshold level. The report 
pinpoints questions that may require re-teaching. The report also provides links to 
remedial instruction resources. Look for the globe icon to indicate that content 
hyperlinks are supported. 
 
Note: Remediation hyperlinks are only available for keywords and state standards. The 
state standard information must include an alignment code in order to link to remedial 
instruction. The ExamView® Learning Series questions include state standard 
alignment codes. Learn more at www.fscreations.com. 
 
You can use the Item Remediation Summary to identify problem areas for your class 
and locate remedial instruction activities to help with re-teaching. The report shows 
the questions that fall above your set threshold, the question type, class average, 
state or learning objective, and hyperlinked keywords and state standards associated 
with the questions. 
 
Remedial instruction is provided through netTrekker d.i. You must have an active 
netTrekker d.i. account to access the resources. To learn more about netTrekker visit 
www.netTrekker.com 
 
 
 

 

 



 

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 80   

Class Roster 
The Class Roster report generates an alphabetical list of the students in a particular 
class. You can create a filter to include all of the class or selected students. 
Additionally, you can customize the Class Roster report by choosing to include the 
supplemental student information (i.e., ID/alias, password, grade, date of birth, 
sociological/economic, etc.). 

 

You might use this report to have a printed record of the ID/alias and password for 
each of the students in each class. You could then conveniently reference this printout 
if a student forgets their ID, alias, or password. However, to maintain privacy of the 
IDs, you would want to keep the printout in a safe place where students and others 
could not access the information. 

 

 

 

Learning Focus 
The Learning Focus report provides a wealth of information to help you identify areas 
where your class (as a whole) needs to focus their learning efforts. To use this report 
effectively, the assignments you create must consistently include data for one or more 
of the following fields: learning objective, local standard, state standard, or national 
standard. 
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One of the key advantages for using the ExamView Test Manager is that you can easily 
gather performance data over multiple assessments. The report shows the number of 
items for each standard, allowing you to gauge whether a standard was adequately 
covered. You can select one or more assignments by category or by date. You must 
also identify a focus range (e.g., 0% - 70%). The program produces a report that shows 
each standard (or learning objective), the number of questions assessed for that 
standard, class average, and how many students are in the focus range. 

 

Similar to the Item Remediation Summary report, remedial content links may be 
available for the Learning Focus report when the focus is set to Learning Objective 
or State Standard. Remedial instruction is provided through netTrekker d.i. You must 
have an active netTrekker d.i. account to access the resources. To learn more about 
netTrekker visit www.netTrekker.com 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: The shaded area (  ) shows the performance for the median 70% of the 
students in your class. For example, if there are 20 students in your class, the top 3 
scores (15%) and lowest 3 scores (15%) would not be included. The range of scores 
represents 14 students or 70% of the class. The diamond (  ) shows the actual class 
average. Use the graphs to see how the majority of students performed. If the area is 
relatively short, students’ scores were similar. 
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Performance Summary 
The Performance Summary report provides a summary of your class’ performance for 
all class assignments in a category over a specified date range. The Performance 
Summary report lists a learning objective/standard, the number of items (i.e., 
questions) that assess that objective/standard, and the proficiency level that the class 
as a whole has attained.  

 
To use the Performance Summary report effectively, you must consistently include 
question information for one or more of the following fields in each of the items you 
create: learning objective, local standard, state standard, or national standard. (Many 
publishers include this information for the questions they provide.) 

 
You can customize the Performance Summary report to generate the performance 
data that best meet your needs. You can select the date range for the class 
assignments, and you can set an appropriate proficiency target (e.g., 70% and above) 
for the class assignments at a particular time in the term. As an example, you might 
set the proficiency target at 70% with the first class assignment that covers a 
particular learning objective/standard. Then, on a subsequent class assignment on the 
same learning objectives/standards, you might set the proficiency target at 80%. 
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Class Performance Progress Chart 
The Class Performance Progress Chart report shows at a glance how each student is 
performing on each of the learning objectives/standards for all assignments in a 
category over a specified date range. The report lists a learning objective/standard, 
the number of items (i.e., questions) that assess that learning objective/standard, and 
a proficiency indicator for each of the students.  

 
To use the Class Performance Progress Chart report effectively, you must 
consistently include question information for one or more of the following fields in 
each of the items you create: learning objective, local standard, state standard, or 
national standard. (Many publishers include this information for the questions they 
provide.) 

 
To customize the Class Performance Progress Chart, you can set the category of 
assignments, the date range of the class assignments, and the proficiency level based 
on your performance criteria. The report shows one of three icons ( ) to 
indicate each student’s performance on each of the learning objectives/standards. 

 
 
 



 

EXAMVIEW ASSESSMENT SUITE   © FSCreations, Inc. 84   

Student Reports 
The ExamView Test Manager provides five reports that highlight each student’s 
individual performance for one or more assignments. This section includes a brief 
overview and a sample of each student report.  

 

Assignment Results 
The Assignment Results report reflects a student’s performance for one assignment. 
The report includes the following information: assignment average, points earned for 
each question, and the student’s response for each question.  

 
If you select the option for performance results for learning objectives/standards, the 
Assignment Results report also includes each learning objective and the following 
performance data for that learning objective/standard: the average, points earned, 
the proficiency level, and the specific questions in the class assignment. To use the 
Assignment Results report effectively, you must consistently include question 
information for one or more of the following fields in each of the items you create: 
learning objective, local standard, state standard, or national standard. (Many 
publishers include this information for the questions they provide.) 

 

You can use this report to identify each student’s proficiency level for each of the 
learning objectives/standards for each assignment. This information may also help you 
to identify areas in which a student may need remedial work. 
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Assignment Review 
The Assignment Review report provides a tool to help your students understand the 
mistakes they made on an assignment. For each question answered incorrectly, the 
report shows the following: points earned, student’s response, correct answer, 
explanation, study tip, and focus area (depending on the information available). 
  

To use the Assignment Review report effectively, you must consistently include extra 
question information for each of the items you create. (Many publishers include this 
information for the questions they provide.) For example, a study tip such as Refer to 
pp. 23-25 is the information in the Reference field for a question. Students, in this 
example, could use the report to refer to the specified pages in their textbook as they 
review the questions that they answered incorrectly. 
 

Students can use the Assignment Review report to review the completed assignments 
and to learn from their mistakes. 
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Student Progress Report 
The Student Progress Report shows a student’s progress for one or more terms. The 
report organizes the results by term and provides the following information for each 
assignment: assignment description, date assigned, category, points earned, percent 
achieved, and class average. A summary shows the term average by listing the total 
points earned out of the total possible points, the equivalent percent, and the class 
average.  
You can use the Student Progress Report to depict the student’s progress over time. 
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Learning Focus 
The Learning Focus report identifies areas where a student needs to focus his/her 
learning efforts. Based on a proficiency level you set, the report lists the learning 
objective/standards that a student has not mastered. For each of the learning 
objectives/standards the student has not yet mastered, the Learning Focus report 
lists the learning objective/standard, the associated number of items, the points 
earned on items, and the proficiency level that the student has attained.  
 

You can customize the Learning Focus report to generate the performance data that 
best meet your needs. You can select one or more class assignments by category and 
the date range for the assignments. You can set an appropriate focus range (e.g., 0% - 
70%) for the class assignments at a particular time in the term. As an example, you 
might set the focus range at 0% to 70% with the first class assignment that covers a 
particular learning objective/standard. Then, on a subsequent class assignment on the 
same learning objectives/standards, you might set the focus range to 0% to 80%. 
 

You can use the Learning Focus report to help a student know exactly what to study 
in order to attain mastery level on the identified learning objectives/standards.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Note: The shaded area (  ) shows the performance for the median 70% of the 
students in a class. For example, if there are 20 students in a class, the top 3 scores 
(15%) and lowest 3 scores (15%) would not be included. The range of scores for 14 
students (70%) would be represented. The diamond (  ) shows your student’s actual 
performance. Use the graphs to see how a student performed in relation to his/her 
class. For example, if the diamond appears near or past the right edge of the shaded 
area, the student’s performance is in the upper range for the class.  If the shaded area 
is relatively short, students’ scores were similar. 
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Performance Summary 
The Performance Summary report shows at a glance how a student is performing on all 
learning objectives/standards for all assignments in a category over a specified date 
range. The Performance Summary report lists each learning objective/standard, the 
number of items (i.e., questions) that assess each learning objective/standard, a 
proficiency score for each learning objective/standard, whether the student is 
proficient based on the proficiency target, and the average for each learning 
objective/standard.  

To use the Performance Summary report effectively, you must consistently include 
question information for one or more of the following fields in each of the items you 
create: learning objective, local standard, state standard, or national standard. (Many 
publishers include this information for the questions they provide.) 

You can use the Performance Summary report to identify specific learning 
objectives/standards where the student needs to focus his/her learning efforts.  
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Print a Report 

After ExamView Test Manager prepares a report, you can print the report in just a 
few simple steps. When you are ready to print a report, follow these general 
instructions. Numerous report options allow you to customize the information that 
appears on the printout.  For detailed instructions and options, see the corresponding 
help topic in the application. 

To print a report… 

1. Click the Report menu and choose a report. 

2. Select the report options. 

3. Click the OK button to display the report. 

4. While viewing the report, click the Print button to 
send the report to the printer. 

 

 

Export Assignment Results 
The ExamView Test Manager lets you export the students’ results data for an 
assignment. You can export summary data (e.g., student name, ID, and percentage) or 
detailed data (e.g., student information, all responses, answer key, etc.). With the 
export option you can export student results in order to import them into your 
gradebook or a spreadsheet. For more advanced users, you can export the results for 
use with a student information system. 

To export the results for an assignment… 

1. Select an assignment. 

2. On the File menu, point to Export, and then click the Assignment Results as Text 
or Assignment Results as XML option. 

 Use the as Text option to export results for use with a gradebook or a spreadsheet 
program. Use the as XML option to export results to a student information system. 

3. Set the options (if necessary) and then enter a file name. 

Note: You can also use the Copy All Class Records option in the Edit menu to copy 
all of the information in the work area.  Then, you can paste that information into a 
spreadsheet document. 

You can set a 
filter to print 
only selected 
students based on 
various criteria.  
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PUBLISH AN INTERNET (HTML) TEST TO YOUR OWN WEBSITE  

Using the ExamView Test Generator, you can publish any test as an HTML document. 
You can choose to create a self-grading study guide or a test that will send student 
results to you via email. After you publish the test, you must copy the files to your 
website so that your students can access the test. 

Publishing an HTML test is a quick way to create an 
online test. However, these disadvantages exist: (1) you 
must have your own website and know how to upload 
files; (2) there are no settings to control when and who 
may access a test; (3) results are not stored in a 
database for access at a later time; and (4) getting 
results via email can be unreliable due to network 
settings and spam filters. 

For many situations, the HTML testing features provide 
an acceptable solution to meet a variety of online testing needs. Review the 
instructions in this section to learn how to publish an Internet (HTML) test. 

Note: Publishers may restrict or prohibit the use of their question bank content on 
public websites. Please refer to the publisher’s copyright notice for information on 
obtaining permissions to use their content online. 
 
 
 
Publish an Internet (HTML) Test 
Follow the instructions below to set the features for the online test and save it to your 
hard drive. 

 

To publish an Internet test… 

1. Start the ExamView Test Generator and create or open a test. 

2. On the File menu, point to Export, and then click HTML. 

3. Enter a test title and choose to export a study guide or a test. 

 A study guide is a self-grading test. You can choose to 
show the rationale, feedback, and reference if your 
test includes this information. Doing so makes the study 
guide a true learning experience rather than just telling 
the students that an answer is right or wrong. 

The ExamView 
Test-Hosting 
Service provides 
a more robust 
Internet testing 
and study 
solution. 

Student feedback 
can include a 
hyperlink to 
remedial learning 
material. 
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 Choosing a test allows students to take it online, and you receive a separate results 
email for each student. You must include a valid email address. You also have the 
option to show a student his/her results after completing a test.  The results email 
will contain the student name and his/her score. 

4. Click the Save button to save the HTML document and image 
files to your hard drive. 

When you publish an online test, the ExamView Test 
Generator saves an HTML file and all of the supporting 
images. The images are stored in a folder named similar to 
the test file itself.  

 

5. Copy the HTML file and the folder with its contents to your 
website. Do not change anything including the folder name. 

 

Note: If you do not know how to copy files to your website and set a hyperlink, 
contact your technology support person. The process varies depending on your 
particular system. 

6. Preview the test before your students take it.  

For tests, answer some or all of the questions. Then, click the Grade & Submit 
button and make sure that you receive a results email. It’s very easy to enter the 
wrong email address. Doing so will cause you to not receive any emails. 
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Take an Internet (HTML) Test 
After you publish an HTML test and copy it to your website, your students can take the 
test anytime from anywhere they can access the Internet. You must provide your 
students with the website address (URL) for them to access the test. 

To take an Internet test… 

1. Start your web browser. 

2. Enter the website address to go directly to the test or to a page with a hyperlink to 
the test.  

3. When the test appears, enter your name (and email/ID if requested).  

4. Complete the test. 

5. When you finish your online work, click the Check Your Work button for a study 
guide or the Grade & Submit button for a test. 

Note: For a test, you will receive a results email for each student shortly after the 
student clicks the Grade & Submit button. 
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APPENDIX  

Technical Support 
Before seeking technical support, please check the following: 

• Is your computer working properly? Try some other software, which you know is 
working, on the same computer. 

• Try the software on another computer. 

• Can you repeat the problem? Does the problem occur at the same point each 
time? 

In order to help you as quickly as possible, have the following information available 
before you contact technical support: 

• Version of the software (e.g., 6.1.0) from the start-up splash screen or from the 
About ExamView… screen (accessed from the Help menu) 

• Brand, model, and configuration of the computer you are using 

• System version (Windows XP, Windows 2000, OS X 10.2, etc.)  

• The exact wording of any error message 

Visit our online support forum (forum.fscreations.com), for quick answers to most 
product questions. Topics on the forum cover everything from explaining product 
features to licensing and purchasing options. The active user community also provides 
useful solutions and product tips on the forum. 
 
If you cannot find a solution to your problem on the forum, contact a technical support 
representative by telephone or email. FSCreations provides technical support for the 
ExamView Assessment Suite. For Publisher versions of ExamView, contact your 
publisher for support. Refer to your publisher’s website to obtain the technical support 
contact information.  
 

 

Using the ExamView Assessment Suite with Other Applications 
Many other products work with the ExamView Assessment Suite software and its 
content. For example, you can deliver a practice test that works with a quiz show 
program or use the test on a handheld (e.g., Palm or PocketPC). The ExamView 
Assessment Suite also works with several bubble sheet OMR scanners to make grading 
your tests quick and easy. 
 
For a complete list of the products that work with the ExamView Assessment Suite, 
visit the FSCreations website (www.fscreations.com). 
 


